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Micro Focus Visual COBOL 6.0 for ISVs
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Documentation Web
site for any updates to the documentation which might have been uploaded.

Product Overview

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio 2017 or 2019. Visual COBOL supports the
development and deployment of both managed .NET and native COBOL applications.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
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view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
Enhancements are available in the following areas:

• .NET Core
• Building Applications
• COBOL Application Console Size
• COBOL Language Enhancements
• Code Analysis
• Code Analyzer Refactoring
• Compiler Directives
• Containers
• Database Access - DB2 ECM
• Database Access - OpenESQL
• Database Access - XA Switch Modules
• Data File Tools
• Debugging
• Deploying Applications
• Eclipse Integration
• Enterprise Server
• Enterprise Server Security
• Enterprise Server Common Web Administration
• File Handling
• Interface Mapping Toolkit
• Library Routines
• Micro Focus Unit Testing Framework
• Microsoft Build Tools and Windows SDK Configuration Utility
• Multi-Threaded Applications
• New Platform Support
• Problem Determination
• Product Documentation
• Visual Studio Integration

.NET Core
Back to Top

Support has been added for .NET Core 3.1, and a number of new .NET Core project templates have been
added.

Note: Because Visual COBOL requires .NET Core version 3.1 and .NET Core version 3.1 is not
supported by Visual Studio 2017, you must be using Visual Studio 2019 to be able to use Visual
COBOL to create COBOL applications to be deployed for use with .NET Core.

Building Applications
Back to Top

This release includes the following new functionality:
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• Maven build support in Eclipse - you can use the Apache Maven support in Eclipse to build COBOL
JVM projects and COBOL JVM Unit Test projects.

COBOL Application Console Size
Back to Top

The maximum console size of a COBOL application has increased. It can now be 255 lines by 255
columns, configurable using the screen_lines and screen_cols run-time tunables.

COBOL Language Enhancements
Back to Top

The following enhancements are available:

• Enterprise COBOL 6.2 Update - new syntax, library routines, and the respective analysis tooling are
available for compatibility with IBM's Enterprise COBOL 6.2 Update:

• New intrinsic functions are supported: BIT-OF, BIT-TO-CHAR, BYTE-LENGTH, HEX-OF, HEX-TO-
CHAR, NUMVAL-F, TEST-NUMVAL, TEST-NUMVAL-C, TEST-NUMVAL-F, and TRIM

• A number of intrinsic functions now support national data (especially surrogate pairs): REVERSE,
ULENGTH, UPOS, USUBSTR, USUPPLEMENTARY, UVALID, and UWIDTH.

• A LOC phrase has been added to the ALLOCATE statement to define whether memory is allocated
above or below the 16MB line.

• CONSTANT qualifier - it is now possible to define data items as constants. This improves the code
readability and usability, and helps detect programming errors. The ability to create constant items is
already in .NET COBOL and JVM COBOL, and many other languages.

• Local variable declarations in native COBOL - it is now possible to declare data items inline in the
code and not only in a separate DATA DIVISION. This provides better locality of data, making the
source code easier to reason about.

• Native data type to hold strings of utf-8 characters - in native COBOL, support is now available for
the PIC U data type as introduced by IBM in Enterprise COBOL version 6.3. Direct support is available
for utf-8 data.

• Performance improvements - this release provides various performance improvements, most
significantly on 32-bit Intel x86 platforms. When using the highest optimization level, opt(4), the
performance of native code generated by the COBOL Compiler has improved. A number of cases are
affected, most particularly those where it is beneficial to locate PERFORM ranges inline.

Code Analysis
Back to Top

Support is provided in Visual COBOL for accessing the Application Analysis Server which is part of the
Micro Focus Enterprise Analyzer and Micro Focus COBOL Analyzer products.

If you have one of these products installed, you can connect to the Application Analysis Server from Server
Explorer and access the Enterprise Analyzer web client. Enterprise Analyzer web client provides quick
searches for repository objects, detailed code searches, diagrams, reports, and data item impact analysis
and other features such as viewing and editing of business rules (separate license required).

Code Analyzer Refactoring
Back to Top
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Support is now available for extracting program logic from COBOL code and moving it to a new program.
The following commands are available from the editor context menu:

• Create program from Section
• Create program from Computation
• Create program from Condition

In Eclipse, you can now refactor your code using the Extract to Section command available from the
Refactor menu.

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

• DISPLAY-AT - specifies a default foreground and background color for DISPLAY AT and ACCEPT AT
statements that do not specify any color attributes.

• DPC-IN-DATA - controls whether the DECIMAL-POINT IS COMMA clause (if specified) is applied to the
output from the XML GENERATE and JSON GENERATE statements.

• ILCONDITIONPARAM - switched on by default. Enables the support for conditional expressions as
method parameters.

Important: Applications that use the old COBOL syntax for specifying named parameters as
custom-attributes will not compile with the ILCONDITIONPARAM specified. This can result in any
older applications failing to compile in the current version of the product. See
ILCONDITIONPARAM for details about how to work around this issue.

The following Compiler directives have new options:

• CHECKREFMOD - now takes an additional parameter (NOZEROLENGTH), which acts as
CHECKREFMOD, but does not permit reference modifier lengths of zero.

• PROTOTYPE - now supports options that specify whether prototypes are required, and the severity of
error messages issued for prototype mismatches.

Containers
Back to Top

Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.

Support has been added to enable the use of tools that are compatible with the Open Container Initiative
(OCI) on platforms where they are supported. This is currently available on Red Hat Enterprise Linux 8.

Database Access - DB2 ECM
Back to Top

Support for the following has been added to this release:

• Multi-row fetch (MRF) and insert (MRI) statements with or without the FOR ROWS clause
• Array update and delete statements

Notes:
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• These new features are supported for DB2 LUW version 11.1 Mod 4 Fix Pack or newer. Currently,
IBM does not support either of these features with DB2 LUW 11.5.

• For coding examples, see the IBM DB2 LUW documentation: Embedded SQL/COBOL Support for
MRI and MRF.

Database Access - OpenESQL
Back to Top

Support for the following has been added to this release:

• .NET Core 3.1 with the COBOL .NET Core project templates "Console Application" and "Class Library"
using OpenESQL directive DBMAN=ADO.

Database Access - XA Switch Modules
Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

Support for the following has been added to this release:

• XA switch modules have been enhanced to enable storage of sensitive information in the Micro Focus
Vault Facility. This new functionality includes a customizable program, ESXAEXTCFG.CBL, you can use
to obfuscate xa-open strings by storing them as secrets.

Data File Tools
Back to Top

The following enhancements have been made to the Data File Editor:

• Double-byte character sets are now supported within the editor.
• Insert mode is now available when editing a formatted record, except for numeric fields.
• When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are

automatically added when editing a formatted record and you are editing in Insert mode.
• You can now load and unload structure files for an open data file.
• A ruler at the top of the editing pane can be toggled on/off.

Debugging
Back to Top

The following enhancements are available in Visual Studio:

• Debug profiles - COBOL projects now support debug profiles, a feature of Visual Studio, where a debug
profile stores a set of properties which specify how to start debugging the application. You can create
and manage multiple debug profiles available on the Debug tab in the project's properties.

• Expressions - you can now specify complex expressions in the Watch window. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Watch Window for details.

This following enhancements are available in Eclipse:
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• Breakpoints - in JVM COBOL, you can now access a breakpoint's properties from the breakpoint's
context menu in the editor.

• Expressions - you can now specify complex expressions in the Expressions view. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Views in the Debug Perspective for details.

Deploying Applications
Back to Top

This release supports easier deployment of native COBOL applications from an Eclipse project. A new
page in the project's properties, Micro Focus > Build Configuration > Deploy, enables you to specify a
deploy folder and which files will be deployed. Building the project deploys certain executables and
supporting files to this folder. In addition, you can archive and deploy the files on application servers, cloud
storage such as AWS buckets and access the application files with AWS services, and so on.

Eclipse Integration
Back to Top

The following enhancements are available:

• COBOL compile settings summary - this pane, which is displayed when viewing the COBOL project
settings at the project, folder, and file level, now indicates the settings that are inherited and the ones
that are set at that level. Settings inherited from the level(s) above are shown in <>.

• Deploy folder - a new build configuration feature in the project's properties enables you to copy build
artifacts and supporting files essential for deployment, to a particular folder.

• Context menu improvements - the editor context menu has been reorganized, where certain options
have been grouped together under a logical heading, and other redundant options removed.

• Copybook tooltips - hovering COPY statements in the editor now displays the path to the referenced
copybook.

• Collapsible statements - it is now possible to collapse IF, EVALUATE, and PERFORM statements in the
editor.

• Dark theme with COBOL - you can enable the dark theme from Window > Preferences > General >
Appearance > Theme.

Enterprise Server
Back to Top

The following enhancements are available:

• IPv6 support (EAP) - This feature is in Early Adopter Program (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.

• Administrative Commands - the add command in cascertreg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).

Enterprise Server Security
Back to Top
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This release provides the following enhancements:

• Micro Focus Secrets file storage permissions

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.

• Certificate wildcard support

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, server1.mycorp.com, and so on. These wildcard-
bearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.

• Improved ACL wildcard support

In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.

• PAM ESM module

On Linux platforms, Enterprise Server now includes an External Security Manager module which
integrates with the Pluggable Authentication Modules (PAM) operating system feature. The PAM ESM
module can be used to authenticate Enterprise Server users with the same mechanism used for Linux
users, or with any other mechanism available through PAM.

• PKIX compliance for TLS certificate validation

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.

• Security improvements for XML parsing

In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

This release offers the following new features and improvements:

• MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/I, MQ,
and XA options, and security, is now available.

• ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.

12 | What's New



• Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, and security menu
items.

• Usability improvements

• Starting and stopping regions from the navigation tree.
• The native menu items are not displayed if the region features are not configured correctly.
• Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.

• Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORs)
association with its PAC and member regions.

• Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:

• Redis cluster support
• A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.

You can also use the file to configure Lua scripts tracing on servers.
• Authentication support for the standalone Redis server.

• Kubernetes support - when ESCWA is run in a Kubernetes cluster, it is now possible to configure it to
automatically discover the pods hosting MFDS within the cluster, and display them in the ESCWA user
interface.

File Handling
Back to Top

Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
microfocus/fh, using the mfsecretsadmin utility.

To ensure the Fileshare server uses the file stored in the vault, start the server with the /uv option.

Interface Mapping Toolkit
Back to Top

Improvements are available in the following areas:

• Resource-based REST APIs - the following enhancements enable the creation of resource-based
REST APIs:

• Operations in JSON RESTful Web services can now have a customizable URI path that identifies a
resource. Operation paths have support for dynamic templating.

• API resources can now be automatically identified from COBOL groups in a COBOL program, and a
set of operations can be generated for each API resource.

• It is now possible to specify the location of interface fields in the service request or response. An
interface field can either be a parameter in the URI path, a query parameter, or be in the JSON
message body.

• Summary support for OpenAPI - the IMTK now supports the OpenAPI Specification (originally called
Swagger) which is the most widely-accepted format for REST API specifications. Features include:

• Consumption of OpenAPI 3.0 and Swagger 2.0 files for purposes of client and service generation.
• Generation of OpenAPI 3.0 files to describe the APIs of a JSON RESTful Web service.

• REST service output filtering and field selection - Enterprise Server JSON RESTful Web services
now include the following features:

• Automatic filtering of the JSON response body of a Web service by path and query parameters
received in the request URI.
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• A special query parameter "$fields" that can be used to indicate that the JSON response body is to
contain only certain specified fields, and to exclude all other fields.

• REST API discovery - Enterprise Server API discovery is now supported. For a JSON RESTful Web
service, a list of all its available operations, and their URI paths, can be retrieved. This enables a client
to efficiently navigate an Enterprise Server REST Web service without having information about the
service’s operations ahead of time.

Library Routines
Back to Top

The following library routines are new:

• MFU_GET_FILE and MFUGETF - both these routines are used with data-driven tests in the Micro
Focus Unit Testing Framework. If the .csv file under test references external data in one of its cells
(using the @file-name notation), use either of these routines to load that external file into memory
before such tests are run.

The following library routine contains new functionality:

• CBL_GET_EXIT_INFO - this library routine has been enhanced to better detect the circumstances in
which an exit procedure has been invoked.

The Micro Focus Unit Testing Framework
Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• You can now run unit tests against an executable file from both the IDE (new in Eclipse) and the
command line. Before you run such tests from the command line, you must initially rebuild the
executable in order to link it into the testing framework.

• You can now produce a report file that can be opened and viewed in Microsoft Visual Studio. Use the -
report:trx command line option to generate a .trx file.

• The .csv source files used in data-driven tests can now reference external data: use the @file-name
notation in a cell to use the contents of file-name in the tests. The external source files must be
loaded into memory, using the MFU_GET_FILE or MFUGETF library routines, before the tests are run.

• Two new elements are available for data-driven tests: a data-driven setup and a data-driven teardown.
Conventional setup and teardown entry points would run multiple times during a data-driven test; these
two entry points run only once per test run.

The Microsoft Build Tools and Windows SDK
Configuration Utility

Back to Top

On Windows, the Visual COBOL setup file now installs the Microsoft Build Tools and the Windows SDK
packages, as these are dependencies for a number of features and operations of the product.

You can use the Microsoft Build Tools and Windows SDK configuration utility to view the package versions
in use in your COBOL environment. You can also use this utility to set the environment to use other
versions of these packages that you have installed.
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Multi-Threaded Applications
Back to Top

This release includes the following improvements:

• Improved validation of detached threads on UNIX - the reliability for applications with many threads,
when using the CBL_THREAD_KILL routine and during abnormal process termination, such as when
an error occurs, has been improved.

• Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.

New Platform Support
Back to Top

Support is now available for Development Hub for the following additional platforms to the same level that
other UNIX platforms (different than Linux) are supported:

• Ubuntu Linux 18.04.x (LTS) on 64-bit Intel (x86-family)
• CentOS v7 and v8 on Intel x86-64

For a full list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Problem Determination
Back to Top

The following enhancement is available:

• Consolidated Tracing Facility (CTF) on UNIX - CTF is now always present during process
termination, such as when an application, or a third-party code, calls exit() directly.

Product Documentation
Back to Top

The following functionality is new in this release:

• Online context help in Eclipse - online context Help is now the default setting for Visual COBOL.
Requesting F1 help from within Eclipse now opens the documentation available on Micro Focus
SupportLine. You can configure Eclipse to show either local or online help. See Viewing the Product
Help in the After Installing section.

Visual Studio Integration
Back to Top

The following enhancements are available:

• Support for the Visual Studio CodeLens feature (Visual Studio 2019 and later only) - CodeLens is a
clickable visual adornment ( , ) above entry points or number of references above class, section, or
paragraph names.
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In Run Units, CodeLens provides the number of entry points, and also enables you to run and debug
directly from the editor.

• New formatting options - you can now specify different indents for the parent and child items in group
item data in Tools > Options > Text Editor > Micro Focus COBOL > Formatting > Data Division.

• Tooltips for END delimiters - tooltips are available for END delimiters such as end-if, end-perform, or
end-of-statement period. The tooltips show the opening statements.

• Code style preferences - a new category of preferences, Tools> Options > Text editor > Micro Focus
COBOL > Code Style, combines all Visual Studio preferences for the format and style of your COBOL
code.

• Lightbulbs - quick actions are available for inserting an end-of-scope terminator (such as END-IF), and
for extracting sections to new programs.

• Snippets - a new snippet for indexers is available.
• Uppercase mode - to toggle uppercase mode, click  (Force upper case in the editor) in the COBOL

toolbar, or enable it from Tools > Options > Text Editor > Micro Focus COBOL > Text Casing). With
this option enabled, code you insert or paste in the editor, including snippets, is forced to upper case.
This functionality must not be used with .NET COBOL.

• QuickInfo - information in the QuickInfo details is now colorized.
• Copybook properties - the Properties window now displays the full path for copybooks that are stored

outside of the project.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Call prototyping in library routines
• Common Communications Interface
• Compiler
• Database Access - OpenESQL
• Data Tools
• DB2
• Documentation
• Early warning of compatibility issues with current operating systems
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• File Handling
• IDE
• Interface Mapping Toolkit
• Micro Focus Directory Server
• National data items in .NET COBOL and JVM COBOL code
• Rebuild required for projects unable to locate the Windows Resource Compiler
• Run-Time System
• SQL Option for DB2
• VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when

ODOSLIDE in effect

Adis

Back to the list

• In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.

3138718 (1112690)

Call prototyping in library routines

Back to the list

The copybooks cbltypes.cpy and cblproto.cpy, provided by this system for call prototyping in library
routines, include features of the latest syntax, specifically the CONSTANT keyword. If these files are used
in conjunction with the MF directive, it should be set to the current level, 21; otherwise, you should remove
the directive, or do not use these copybooks.

Common Communications Interface

Back to the list
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• The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.

Compiler

Back to the list

• "file not found" error messages now provide more information about the key the user needs to press.
The new format of the messages is as follows: "File name.cpy not found - Press [S]top/[R]etry/
[C]ontinue/[A]lter-path".

• External data and files declared in an instance context (such that is not within STATIC/END STATIC and
without the STATIC qualifier) can no longer be accessed from a static method. The STATIC qualifier is
now allowed in combination with EXTERNAL.

3216822 (1119228)

Data Tools

Back to the list

• You are no longer able to modify data in a structured record that is identified as comp-2 floating point -
an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.

3213037 (1118867)
• Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see

'Working with Different Character Sets' in the documentation for more information.

3161243 (1114482)

Database Access - OpenESQL

Back to the list

Just like other DBMS SQL COBOL precompilers, OpenESQL now follows embedded SQL standards and
disallows the use of group host variables in WHERE <column> = :hostvar clauses. In the past, this was not
flagged at compile-time, and would lead to unpredictable results when executed.

DB2

Back to the list

• There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)

Documentation

Back to the list

• The information about the -flag and warn compiler options has been updated.

3190928 (1120000)

Early warning of compatibility issues with current operating systems

Back to the list

In order to better support modern operating systems, we are aligning closely with their operability
guidelines. We now detect previously-undefined behavior when interacting with OS level functions.
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Error RTS096 alerts you to any calls to the operating system's fork() API, in a process that has directly or
indirectly called COBOL functionality, in your code.

The error gives you an early diagnosis of a situation which, if left unchecked on modern operating systems,
could lead to deadlocks, crashes or other failures at run time. These problems would often occur
intermittently and be very challenging to track down.

See the KB article https://community.microfocus.com/t5/Visual-COBOL-Knowledge-Base/fork-rts64-
Error-96-encountered-in-child-process/ta-p/1771191 for more details.

Enterprise Server

Back to the list

• IF an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_????_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.

3213379 (1118913)
• The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the

command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.

(642125)
• Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites" in the "Scale-Out

Performance and Availability Clusters" chapter in your product Help for more information.

• When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.

3223257 (1119804)

Enterprise Server Common Web Administration

Back to the list

• By default, ESCWA now runs on port 10086.
• When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique

Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.

• PAC names are now limited to eight characters or fewer in ESCWA.
• The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server Security

Back to the list

• The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.
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3206992 (1118359)

File Handling

Back to the list

• The supervisor password is no longer displayed when cobfsclose is executed from the command line.

3195772 (1117571)
• Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

3120656 (641976)
• Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting

Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.

• File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.

IDE

Back to the list

The resolved issues for Visual Studio are as follows:

• In fixed format COBOL code, lines in custom code snippets will now be automatically wrapped if they
reach the end of area A/B.

3201628 (1117874)
• Server Explorer in Eclipse and in Visual Studio now requires you to specify user names and passwords

if security is enabled to connect to the nodes. The default credentials are no longer automatically
applied.

The resolved issues for Eclipse are as follows:

• A bug that prevented adding multiple Program Breakpoints has been fixed.

3222576 (1119722)
• Environment variables with the format ${env.<name>} are now handled correctly during compilation and

background parse.

3215414 (1119077)
• A new option has been added to the Window> Preferences> Micro Focus> Debug dialog box: Ignore

breakpoints in resources within unrelated projects. When selected, this option guards against the
situation where you have identically-named programs within your workspace, and setting a breakpoint in
one could cause the other programs to break when they are debugged (if the corresponding lines are
debuggable). To continue current behavior, this option is not selected by default.

3211196 (1118694)
• Populated folders can now be used as output folders for JVM COBOL projects.

3210830 (1118646)
• A new option has been added to allow you to edit the location of a remote linked folder. It opens the

same wizard as when creating a new remote linked folder, but in edit mode.

3200758 (1117951)
• It is now possible to access a breakpoint's properties from the breakpoint's context menu in JVM

COBOL code.

Interface Mapping Toolkit

Back to the list
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• The COPYEXT directive on remote projects now works correctly.

3206621 (1118324)

Micro Focus Directory Server

Back to the list

• UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y'.

National data items in .NET COBOL and JVM COBOL code

Back to the list

.NET COBOLJVM COBOL code that uses IS NUMERIC tests on NATIONAL or NATIONAL NUMERIC data
items, or uses NATIONAL NUMERIC data items in programs compiled with the CHECKNUM Compiler
directive must be recompiled in this release. Compiled code from earlier products that uses such
constructs will generate a MissingMethodException error when run under this release.

Rebuild required for projects unable to locate the Windows Resource Compiler

Back to the list

Projects that were last built in a version prior to 6.0, and that rely on the Windows Resource Compiler
(RC.exe) need to be rebuilt in Eclipse, otherwise they may produce an error. This is due to the relocation
of RC.exe in this version of the product. Affected projects will be those that explicitly reference a manifest
file (used to include such things as cursors, fonts, and icons), and that are built directly from the command
line.

The problem is fixed if you open and build the project within the Eclipse IDE (as .cobolBuild is rebuilt to
find the new location of RC.exe). Alternatively, you should ensure that PATH contains a reference to
RC.exe if you continue to run projects from the command line.

Run-Time System

Back to the list

• Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.

3138692 (1112552)

SQL Option for DB2

Back to the list

• The XDB Service name has been shortened.

3195822 (1119897)

VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Back to the list

If your Working Storage contains a data item with the OCCURS DEPENDING ON phrase, and ODOSLIDE
is in effect, any subsequent data items at the same or higher level must not contain a VALUE clause. If they
do, an error (COBCH1962) is now generated.
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If you cannot remove the VALUE clauses from your source code or remove ODOSLIDE, contact
SupportLine.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• Oracle does not support deployed .NET Core 3.x client applications on SUSE Enterprise Linux
accessing Oracle databases.

• An issue with Microsoft's Visual Studio 2019 version 16.8 or later affects .NET Core COBOL projects
created with version of Visual COBOL earlier than 6.0 PU4. To avoid the issue, install Visual COBOL
6.0 Patch Update 4 or later with Visual Studio 2019 version 16.8 or later.

• When debugging containerized Enterprise Server Application projects in Visual Studio, the .car file may
not get deployed to a running container after an initial debug session. This means that any code
changes may not get deployed. To work around this, you need to manually do a rebuild of the project to
force the container to be recreated with the latest changes.

• When using Debug > Attach to Process in Visual Studio to debug a process that is running, if you
detach from the process and then attach to the same process again, a protection violation might occur.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0, the .NET COBOL and JVM COBOL run-times reject
any program using IS NUMERIC on a NATIONAL item which was compiled with a version 5.0 or earlier
of the product. You receive a "missing method" exception. To resolve the issue, you need to recompile
any programs that use this construct in Visual COBOL 6.0.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 are
not affected.

• On Linux, the marketplace client in the supplied version of Eclipse will not work correctly if the product is
installed in a spacey directory. Micro Focus recommends that you avoid installing the product in a
spacey directory on Linux, if you want to install any additional plugins from the Eclipse marketplace.

• The chapter Mainframe Access Installation Guide has been included with the product Help, however,
this feature is not part of the Visual COBOL product.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Character Animator
• Code Analysis
• Code Coverage
• Common Communications Interface
• Compiler
• Data Tools
• Debugging
• Dialog System
• Dockerfiles
• Documentation
• Enterprise Server
• Enterprise Server Auditing
• Enterprise Server Common Web Administration
• Enterprise Server Security
• File Handling
• Form Designer
• Header-to-Copy Utility
• IDE
• Interface Mapping Toolkit
• Licensing
• Micro Focus Common Client
• Micro Focus Directory Server
• MF Server Administrator (GUI)
• Micro Focus Unit Testing Framework
• Run-Time System
• Setup
• SQL: COBSQL
• SQL: DB2
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• A single field is no longer padded to the right when the SIZE clause data-name is greater than the PIC
clause and all the other fields have the PROTECT attribute.

3223862 (1119916)
• An ACCEPT on SECURE fields no longer produces unwanted characters.

3221450 (1119807)
• Using JUST and ZERO-FILL in a CONTROL clause with ADISCF option 16 set to 3 no longer causes

an RTS 114.
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3198021 (1117521)
• ACCEPT ON ESCAPE KEY and ACCEPT ON ESCAPE data-item now return the correct key-code in

RM/COBOL for function keys and escape. Note that the complete list of the returned key codes are not
100% compatible with RM/COBOL for all keys.

• You no longer receive an RTS 114 error when the UNIX environment variable COLUMNS > 164 for
DISPLAY AT LINE COLUMN syntax.

Character Animator

Back to the list

• A Perform Step of a CALL statement in INT code, after using the Do function, and then changing the
execution point with the Reset function, now steps over the CALL correctly.

3222172 (1119750)
• When detaching the debugger from a process on Solaris, the process no longer crashes.

3213587 (1118926)
• Two new command line options for Animator can be used to speed up the Animation of coredumps for

applications with a large number of programs. Specifying these new options "FASTLOAD" and
"FASTEXIT" on the command line will result in Animator starting and stopping significantly quicker. See
the documentation for details on these new options.

3212276 (1118852)
• CBL_EXIT_PROC routines can now be debugged correctly.

3208380 (1118433)
• Querying an OCCURS ... DEPENDING ON ... where the item is zero is now treated as an invalid query

and the item is not shown.

3201182 (1117795)
• When zooming and using Perform Step/Out over applications with many programs which have many

COPY statements, performance is improved.

3197159 (1118692)

Code Analysis

Back to the list

• A change has been made to allow DFHEIBLK to appear as an input and output parameter to extracted
components created in Logic Analyzer.

3226429 (1120119)
• The structure slice no longer generates unnecessary copybooks.

3226424 (1120105)
• Display statements now support the vertical bar symbol (|).

3217022 (1120020)
• If a project contained source files that were included as part of a linked folder, sometimes the resolved

location of those files was being corrupted, and so the code analysis functions could not execute
correctly. The required paths are now passed correctly to the compiler.

3207365 (1118363)
• An issue in Logic Analyzer where comments may not be deleted from an extracted component source

file has been fixed.
• An issue that caused incorrect code generation for variable-formatted COBOL in Logic Analyzer has

been fixed.
• An issue caused by the checker not generating end coordinates for the FILE SECTION in the

kenlygen .xml file has been fixed.
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• An issue where the REPLACING clause would sometimes be omitted from a COPY statement in code
generated by Logic Analyzer has been fixed.

• An issue where Logic Analyzer could generate syntactically-incorrect code when processing free-
formatted COBOL has been fixed.

• An issue with fall through in Program Control Flow when the program has multiple program entries has
been fixed.

• An issue that could cause an abend on some Logic Analyzer extraction operations has been fixed.

Code Coverage

Back to the list

• Test Coverage result files containing results for different programs can now be merged correctly by the
IDE.

3202218 (1117937)
• The tcreport tool (or cobtcreport on UNIX) no longer requires write permission for the .tcz test coverage

results files it reads.

3197117 (1117439)

Common Communications Interface

Back to the list

• When CCI shared memory was processing multiple simultaneous broken connections and data at the
same time, it was possible that the data could not be read.

3195698 (1117370)
• ssltrc.txt is no longer created with an extra character in the file extension.

Compiler

Back to the list

• A new Compiler directive, DPC-IN-DATA, enables you to control whether the DECIMAL-POINT IS
COMMA clause (if specified) is applied to the output from the XML GENERATE and JSON GENERATE
statements.

3225204 (1119993)
• Multiple undefined data items in the same statement are now all correctly detected and reported as

such.

3224326 (1119891)
• STRING <national/DBCS-item> WITH POINTER no longer gives incorrect '1045-W Capacity of

POINTER may be exceeded' warning message.

3224231 (1119879)
• Programs with data items that have a REDEFINES clause and are defined from typedefs now compile

as expected with the INIT-BY-TYPE directive.

3224059 (1119884)
• A JSON PARSE statement will now accept a null value when the associated COBOL item is a group

structure. The whole group will remain unchanged, with parsing continuing (with a non-exception json-
status code).

3222416 (1119788)
• Programs that contain XML or JSON statements now compile as expected with the MF(19) Compiler

directive.

3220175 (1119526)
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• The compiler will now give an error message if the class condition IS NUMERIC is used on a PIC G
variable.

3219148 (1119408)
• A multi-program source which contains a very large number of programs now compiles as expected and

no longer produces spurious messages about memory issues.

3218772 (1119405)
• An XML GENERATE statement in a native OO program which requires the use of the

REPOSITORY(UPDATE ON) directive, now generates correct xml output with the case of names
preserved from the one specified in the source.

3217436 (1119293)
• Project that use stacked preprocessors, including prexml and cobsql, now show the correct colorization

and copybook dependency information following multiple background parse operations.

3217164 (1119270)
• The length and byte-length intrinsic functions can now accept pointers and index-names as arguments,

as described in the product documentation.

3216240 (1119197)
• Intrinsic functions such as ABS, SIGN, EXP and EXP10 are now supported under the ENTCOBOL

dialect which emulates IBM's latest Enterprise Cobol release.

3215473 (1119088)
• A COMPUTE statement which followed a statement referencing a boolean data item now compiles as

expected, without giving an internal error.

3215314 (1119160)
• A data name immediately followed by an opening parenthesis of an abbreviated condition now compiles

successfully.

3210121 (1118623)
• Compilation of statements which reference floating-point fields with nested subscripting now produces

correct object code, and executes as expected.

3209711 (1118555)
• A report file that does not have a record definition, and specifies a RECORD CONTAINS clause of

larger size than the value of the REPORT-LINE directive, now produces correct report output.

3208971 (1118489)
• An inline method invoke passing a numeric literal to an ANY LENGTH parameter is now working as

expected.

3206678 (1118306)
• Filenames that contain Swedish characters now appear correctly in the Visual Studio error output. This

enables the subsequent error location to work correctly.

3204665 (1118778)
• A JSON GENERATE statement with a NAME clause which renames a group item in the generated json

to the value of a 78 item now compiles and executes as expected.

3204281 (1118109)
• The N symbol type for VALUE clauses of 88 levels associated with a NATIONAL data item is now

correctly inferred to be NATIONAL. (The preferred solution, however, is to set NSYMBOL(NATIONAL)
correctly.)

3204277 (1118077)
• Provide a directive DISPLAY-AT(foreground-color background-color) to specify default colors for any

ACCEPT or DISPLAY AT which does not already use a color clause. See the directive entry in the
documentation for more details.

3201040 (1119380)
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• COBOL words that include non-standard characters rejected by IBM's Enterprise COBOL are now
similarly flagged under appropriate mainframe dialects.

3199487 (1117690)
• A UTF-8 source with the currency-sign set to the Euro symbol now compiles as expected, provided the

file has a byte order marker or the ENCODING(UTF8) directive has been specified. (Note in Visual
COBOL/Enterprise Developer the directive is now called SOURCE-ENCODING.)

3199087 (1117629)
• Mainframe behavior concerning what syntax is allowed prior to a REDEFINES clause in a data

description entry is now better emulated under a mainframe dialect.

3195091 (1117380)
• A VALUE clause on an item defined via a typedef and compiled with the INIT-BY-TYPE directive now

compiles as expected.

3194326 (1117195)
• A DISPLAY statement which uses the DISPLAY-OF intrinsic function and is compiled with the

CHARSET(EBCDIC) Compiler directive, now produces the expected run time results.

3191395 (1117115)
• An ADIS DISPLAY of national data now executes as expected.

2666775 (608918)
• Previously, when profiling code, if control trickled through a GO TO DEPENDING because the value of

the index variable was out-of-range, time could be counted against the wrong paragraph.

• For 390 Linux only. Given declarations: 01 a pic 9. 01 b pic 9(15)v99. a statement: move a to b could in
some circumstances give an internal error 98 at generate time. This bug has been fixed.

3225211 (1120021)
• In generated code, on all platforms except Intel x86 32-bit, a very simple program (that is, one with no

calls, file handling or display operations, or any complex operations) that specified DBSPACE"mixed"
could give the wrong result or a 114 run-time error.

3218551 (1119351)
• An internal logic error could occur within the NCG when compiling deeply nested IF statements (more

than 16 levels deep) in a program compiled with DATA-CONTEXT or PIC. This could only happen on
Intel x86 platforms and with 32-bit generated code.

3218376 (1119347)
• A bug in the Intel x86 32-bit generated code for statements of the form: multiply -1 by x where x is a

COMP (including COMP-4) item and the TRUNC directive specified, has been fixed.

3199580 (1117691)
• A bug in generated code has been fixed, where COMPUTE statements containing terms of the form:

function numeric-function(args) * 0 where numeric-function is any numeric intrinsic function, could have
unpredictable results at run time.

• If an EVALUATE with single selection subject used the WHEN ANY syntax, bad code could result. This
is now fixed. Although the use of WHEN ANY in such a context is legal, we recommend you instead use
WHEN OTHER. If the WHEN ANY was the last WHEN branch of the EVALUATE, it can simply be
changed to WHEN OTHER. If it was not the last branch of the EVALUATE, then any following branches
would never be reached, and can be deleted.

3220298 (1119515)
• A level 88 condition name associated with a sliding data item in the linkage section was producing bad

code and system errors.

3214482 (1119037)
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• A system error no longer occurs when attempting to find a method in a class, in the case where an
override of that method has a parameter of an unknown type (that is, a type which is not on the class
path).

3212502 (1118804)
• When a program is compiled for JVM, for methods including lines whose sequential line number

exceeds 65536, an annotation com.microfocus.cobol.info.LineBias is now added which has an integer
value. This value indicates the increment which you must add to the line numbers reported by an
exception, in order to find the true line number of the statement that caused the exception.

3211681 (1118851)
• A LineBias annotation (with an integer value) is now present for debuggable methods and procedures,

where the last statement of the method is on a line whose line number is greater than or equal to
65534. This value may be used to deduce the true line number for a statement within the method,
based on the line number in the LineNumberTable.

3211681 (1119613)
• Use of a property as a subscript for an operand used as a target (e.g. the target of a SET statement)

could lead to spurious errors.

3202739 (1117970)
• When compiling for JVM, if a program or project has a reference to another project whose path contains

non-ANSI characters, the system now correctly finds classes on that path.

3198280 (1117549)
• When compiling for JVM, setting a decimal field (i.e. a field defined using the keyword 'decimal' or

explicitly with type java.lang.Decimal) to a floating-point data item, no longer produces invalid code.

3195996 (1117327)
• If a VALUE is associated with a sliding data item, you will receive error COBCH1962. Contact

SupportLine for help on resolving this.

• If ERRLIST(END) was used together with ILSOURCE, all the errors for all the programs were listed with
the listing for each program. Now only those errors which relate to a single program are included in the
listing for that program.

3225341 (1119990)
• In previous versions of the product, warnings COBCH0656W and COBCH1151W could be produced for

PIC 1 fields with USAGE BIT, in cases where such warnings were inappropriate.

3223726 (1119819)
• Bad code was generated for a constructor that has at least one COBOL-style parameters (such as PIC

X or group linkage records) and at least one .NET native parameter (such as an object or a primitive
type such as binary-long).

3221048 (1119581)
• If an INITIALIZE statement referenced a group with the OCCURS clause (or subsidiary to another group

with an OCCURS clause), and if that group contained PIC 1 USAGE BIT data, then if the INITIALIZE
statement was specified with a non-literal subscript, the Compiler would produce system errors. This
has been resolved.

3219949 (1119477)
• In previous product versions, with programs compiled for .NET or JVM and using the INDD or OUTDD

directive, if the SYSIN or SYOUT variable was not set, or pointed to a non-existent file, no error
occurred when an ACCEPT or DISPLAY statement was executed. In this version a run-time error is now
produced when the first ACCEPT or DISPLAY statement is attempted.

3219143 (1119406)
• Invocations to specific generic overloads within a super class, where multiple overloads exist with the

same parameters, now compile successfully.

3215786 (1119127)
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• If a program included an invoke statement with a parameter requiring an implicit conversion, compiling
with the RVGEN directive could cause the compiler to crash. This could occur if the program was a
WinForm program loaded into Visual Studio.

3214005 (1118981)
• Previously, with PERFORMTYPE"RM" in effect, and when an ECM preprocessor was in use, a STOP

RUN at the end of the user program could sometimes cause the compiler to crash with an error 114.
This is now fixed.

3213280 (1118885)
• Bad code was produced when OCCURS appeared in a screen section item, which also has a LINE or

COLUMN clause referencing another table with OCCURS.

3211797 (1118801)
• When compiling a multi-program source unit for managed code (by using the ILSOURCE directive, or

through an IDE project with multiple source files), the listing for the individual sources did not always
indicate the correct number of errors/warnings. This has now been fixed.

3211333 (1118701)
• When compiling for .NET or JVM, the SAME RECORD AREA clause was not always effective.

3210757 (1118644)
• When compiling for .NET or JVM, a STRING statement involving both string objects and linkage records

could produce bad code.

3209650 (1118560)
• When a .NET project has a reference to an assembly, which itself has references to a dependent

assembly, and if the project does not have an explicit reference to that dependent assembly, error
messages of the form 'Failed to find system program 'EXTFH'' could be produced.

3200162 (1117797)
• You now receive a compile-time error if an attempt was made to access an object file (i.e. a file in a

class program defined without the STATIC qualifier on the FD) from a static method. Previously, this did
not result in an error at compile time, but instead produced an invalid program that failed to load at run
time.

3196233 (1117354)
• For a program compiled to .NET COBOL code using the CHECKNUM directive, a MOVE statement

from a numeric DISPLAY field to a numeric edited, where the source contained non-numeric data, was
not producing an error 163. With this release, an error 163 is produced.

3194570 (1117200)
• Conditional expressions are now allowed as method parameters. This requires that the new directive

ILCONDITIONPARAM is set to ON (which is the default). Specify NOILCONDITIONPARAM in order to
maintain compatibility with the old way of specifying named parameters to custom attributes.
Alternatively, change your code as in the following example from: custom-attribute is type
WebServiceBindingAttribute("Name"="ShakespeareSoap", "Namespace"="http://xmlme.com/
WebServices") To: attribute WebServiceBinding(property Name = "ShakespeareSoap", property
Namespace ="http://xmlme.com/WebServices")

• Under DotNetCore (.NET Core) support, if HOSTFD is enabled, reading an index file with a record area
less than is expected by the index file could result in a memory corruption. This has been fixed.

Data Tools

Back to the list

• The dfconv command line utility now supports a new option "-s" - this option skips DBCS checking
during conversion, in order to improve performance. This option should only be used from within a
DBCS locale, and only when you are sure that the data you are dealing with is from a SBCS.

3213092 (1118872)
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• When running the DFCONV command line batch interface, a new option -F (or -f) allows only the fixed
text output to display; no dynamic updates are displayed to the console after each record is processed.

3163542 (1115730)

• Trying to open a PDS file in DFED no longer results in out-of-bounds exceptions.

3214578 (1119499)
• On UNIX, opening empty structure files no longer fails and produces an RTS 114 error message.

3208560 (1118685)
• Structure files can now be loaded and unloaded after a data file has been opened.

3181265 (1116352)

• On UNIX, using the Up and Down buttons to navigate the records no longer causes Data Tools to hang
and loop at several rows.

3208560 (1118686)
• Conditional structure now work with EBCDIC files where the condition field is not at the beginning of the

record.

3204158 (1118166)

Debugging

Back to the list

• When animating programs where the source name differs from the program name, breakpoints are now
set correctly.

3210556 (1118743)
• The debug option 'Only stop on breakpoints' in Eclipse used during Enterprise Server debugging now

works correctly.

3201358 (1117960)
• Attaching the debugger to a running process is now quicker than previously.

3198107 (1117569)
• When zooming over applications with many programs which have many COPY statements,

performance is improved.

3197159 (1117509)

• Values of sliding variables are now presented properly while debugging.

3219710 (1119601)

Dialog System

Back to the list

• The Export process in Dialog System no longer fails with RTS164 error.

3200921 (1117781)

Dockerfiles

Back to the list

• esadm is the default user for all the different container images.

Documentation

Back to the list
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• The K4 switch is now correctly documented in the Visual Studio-related products.

3219902 (1119948)
• The documentation has been updated to explicitly state that the FOLDER tag, used in extfh.cfg, only

supports the use of local folders; it does not support the use of networked folders.

3212247 (1118782)
• The documentation has been corrected in relation to the supported data types allowed in a stored

procedure definition file.

3207946 (1118435)
• The note at the head of the list of run-time tunables, stating that the tunables are for native code only,

has been removed. Any native-only restrictions for tunables are mentioned in the topics of each tunable.

3207815 (1118381)
• The error message description for the warning message COBCH1237 has been corrected. It also now

contains a link to the Compiler directive topic (REENTRANT) that it relates to.

3205344 (1118169)
• The product Help for the software requirements has been updated to indicate that on 64-bit Red Hat 7

you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.

3201443 (1118038)
• The cbllink option -s has been correctly removed from the documentation.

3200100 (1117719)
• To create an EXTENDEDESDS file, the docs now state that you must use a combination of

IDXFORMAT"15" and the EXTENDEDESDS option.

3195595 (1117298)
• The syntax diagram for indexed file formats (format 4) has been updated in the documentation - topic:

The File Control Entry. It now indicates that WITH [NO] DUPLICATES can be specified on the record
key, as an MF extension.

3177534 (1115898)
• When using Just-In-Time debugging with Eclipse, a confirmation prompt can be displayed, asking for

confirmation before Eclipse is launched.

3167492 (1115034)
• The documentation on the FILE_TRACE configuration variable (used within Database Connnectors)

now includes details on the level of tracing that is possible.

3164533 (1117209)
• The Restrictions that appeared on all IMTK topics indicating that the topics applied to Windows (local

development) only have either been removed or updated to reflect Windows only.

3164533 (1115095)
• The RM/COBOL compatibility documentation now makes it clear that the DIALECT"RM" directive

should not be applied to managed COBOL.

3139755 (1112643)
• The documentation now includes the sequence in which the Run-Time System will attempt to locate a

requested .lng file - see 'Compiling and Deploying a Message File'

2869115 (1106127)
• The documentation has been corrected with regards to one of the parameter names used with

the .cobolBuild script used with Apache Ant. The correct parameter name (previously stated as
threadCount) is mf.buildThreadCount.

• Clarification has been added to the documentation about the VISUALSTUDIO Compiler directive. It is
reserved for internal use, even though it appears on the directives settings list.
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• The context-sensitive reserved words, particularly those relating to the ACU dialect, have been
relocated to the Context-Sensitive Reserved Words topic. (They previously resided in the Reserved
Words Table topic.)

• If you are building a self-contained callable shared object on a Linux platform, and will be calling
COBOL modules built to .int or .gnt files, you must specify the following additional options when you link
the main (non-COBOL) executable: -Wl,-zexecstack For example: gcc -m32 -o mymainexe mymain.o -g
-ldl -Wl,-zexecstack

• Erroneous text re: background syntax checking, in the 'Editing Standalone Files' section of the topic
'Writing Code Efficiently in the COBOL Editor', has been removed.

• The 'Unit Testing from the Command Line' section of the MFUnit documentation now contains a list of
possible error codes generated when running tests from the command line.

• The documentation has been updated to clarify the default behavior when the ALIGN directive is
specified without either OPT or FIXED.

• The documentation for the Micro Focus Database Handler now clarifies when a region and cross-region
database is required (in the Configuration Requirements section).

• The sample code listed in 'Typedef - User Defined USAGE or Structure' has been corrected.
• The procedure for installing Visual COBOL for Visual Studio into an offline environment has been

updated. See 'Installing Visual COBOL in an Offline Environment' in the product documentation.

(643830)
• The documentation has been corrected for the TYPEDEF clause - the list of clauses not permitted for

use when TYPEDEF is specified is now accurate.
• Details of how to configure a specific run-time environment (using an application.config file) for .NET

tests run from Visual Studio has been added to the documentation.

(643605)
• The documentation has been updated to state that the maximum number of PERFORM ranges in a

program (65535) is also applicable to .NET and JVM COBOL programs.
• COBOL cheat sheets have now been successfully re-instated.

• All erroneous references to the TRUNC, BS2000-OFFLOAD, and INFORETURN directives have been
removed from the documentation.

3223245 (1119786)
• All erroneous references to the FLAGCD directive have been removed from the documentation.

3223242 (1119785)
• All erroneous references to the [NO]OLDSTRSUB directive have been removed from the

documentation.

3223240 (1119783)
• On UNIX, MFDS can run as a non-root user on a port number equal or greater than 1024. See "To Run

the Directory Server as a Non-Root User" in your product Help for more information.

3213301 (1118928)
• The documented example for the mf.mfdbfh CTF component now contains the correct settings in order

for the trace to be successful.

3203127 (1118015)
• The documentation has now been updated with the correct definition for the CCITCPS_fsname variable,

used within Fileshare.

3192544 (1117368)
• The DD Statements topic has been updated to include correct values for XTEP2 and its alias

DSNTEP2.

3168080 (1115120)
• The Interface Mapping Toolkit topic under Known Issues and Restrictions has been updated to clarify

support for the ODOSLIDE compiler directive.
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3152222 (1113733)
• The documentation now correctly states that the CBL_CREATE_CORE library routine is for native

COBOL use only.
• Ensure that you back up your secrets configuration file, secrets.cfg. Before you install a new version of

your product. By default, the secrets.cfg file is located in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\etc (Windows) or $COBDIR/etc (UNIX) directory. Restore the backed up
configuration file once the product installation is complete.

3216092 (1119162)

• The documentation now includes details of the MFJ_STRICT_CASE environment variable, which can
be used to maintain the case of physical file names passed to MVSCATIO by the catalog API, and other
utilities.

Enterprise Server

Back to the list

• TS queues that were created with an expiry interval and stored in Redis would have their expiry interval
corrupted when a subsequent READQ TS was performed on that queue. The expiry interval is no
longer modified during the life of the queue.

3221103 (1119598)

• In a PAC, when a JES initiator was terminated, if the job was in the Dispatch queue the lock was not
removed for the dispatch queue SYSZJOBD.

3226274 (1120084)
• It is now possible to use casfile -p to change the current path of a closed file or, if the file is cataloged, to

change the DSNAME from the specified DD NAME.

3224800 (1119969)
• An issue causing an RTS 114 on DFSRRC00 related to disabled xa entries has been resolved.

3223838 (1119845)
• You can now set the environment variable ES_PAC_NO_GLOBAL_LOG=Y if you do not want all the

messages from all console.log files for all the regions in a PAC to be stored in the PSOR CasPacLog.

3222549 (1119714)
• CICS Web requests greater than 32 Kb to secure regions no longer incorrectly receive a 403

(Forbidden) response.

3222308 (1119752)
• Switching on the active HSF file could cause a thread in the castrc process to go into a tight loop and

use a lot of CPU.

3219692 (1119546)
• A MalformedResponseException error when using channels and containers on ECI calls has been

resolved.

3217992 (1119653)
• Strings with special characters were sometimes being truncated or causing a malformed XML error. The

whole string is now being returned without any truncation or errors.

3217170 (1119681)
• A CCSID Error 0002 could occur when converting certain strings to UTF-8, if the strings contain

characters that expand from single to multi-byte during the conversion. The reason for this was that the
converted string was longer than the maximum length specified for the field. Instead of resulting in an
error, the data is now truncated. This matches the behavior on the mainframe.

3217170 (1119262)
• The Historical Statistics Facility (HSF) post-processor utility casfhsf has been enhanced to output time

intervals of from 1 to 9999 seconds. An option is now provided to optionally split the date/time output
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column into a date column and a time column. The maximum number of columns has been increased to
172,800 for 32-bit systems, and to 1,296,000 for 64-bit systems. The number of transactions within an
interval that meet its specified system response time criteria is now reported correctly.

3214504 (1119179)
• Calling into an entry point on an already loaded program no longer causes memory leaks.

3214021 (1119003)
• An empty XML element in the SOAP response message no longer results in an ARRAY_TOO_SMALL

error.

3212477 (1118802)
• Tranclass MaxActive is now honoured in PAC configurations.

3209901 (1118571)
• The command line help for casstart now includes information about the /m option.

3208071 (1118414)
• The initialization of a Service Execution Process could be interrupted by a request which provoked a

security call before the local ESM context had been established. This resulted in an error which would
cause the server to shutdown immediately. This has been fixed.

3208021 (1118431)
• An issue on a START TRANSID with TERMID executed from an EBCDIC program has been fixed.

3206507 (1118272)
• The permissions for resources (such as TSQUEUE) were being checked every time they were used in a

transaction. Now they are checked once per transaction and the result of that check is used on
subsequent requests.

3206471 (1118690)
• All BATCHONLY MQ resource managers accessed from the same DSNRLI program are now security

checked. Note that DSNRLI is limited to opening only one MQ resource at a time.

3205339 (1118173)
• If one or more jobs had a shared lock on a dataset (DISP=SHR) and another job was waiting for

exclusive access (DISP=OLD) on the same dataset, the latter would be granted the lock when any one
of the other jobs completed. The file would not be available for exclusive use and this would result in a
9/65 error, file locked status on open. This has now been resolved and the exclusive lock is not granted
until all shared locks have been released.

3201463 (1117839)
• Previously, INQ TRANCLASS could fail and return a TCIDERR response code if CASTSC was handling

a heavy load.

3200414 (1117738)
• ITR requests (such as file requests) are not sent to the transient SEP running the EZASOKET CICS

transaction.

3200370 (1117767)
• Invoking any of the CAS* utilities (such as casout) against an enterprise server instance running on a

machine with a host name which exceeds 40 characters in length no longer results in a failure to find
the service.

3200011 (1117816)
• Previously, a high volume of events in the system could cause shared memory constraints. This was

because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.

3199174 (1117679)
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• Previously, a high volume of events in the system could cause shared memory constraints. This was
because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.

3199174 (1117680)
• ESCERTPAS can now return spaces as the passphrase to allow for certificates that do not have a

passphrase.

3196872 (1117431)
• The following APIs are now supported: MQCRTMH, MQBUFMH, MQMHBUF, MQDLTMH MQSETMP,

MQINQMP, and MQDLTMP.

3196430 (1117373)
• The performance when accessing PPTs for a program that has already been invoked in the same task

has been improved.

3195445 (1117554)
• In the case of OPERCMDS, you need to call the security exit only if the esm-input-parms pointer has

been provided. This helps to avoid receiving an RTS 114 error message.

3195205 (1117377)
• An issue where a process recovery caused the entire region to crash has been resolved.

3192471 (1117060)
• Sysout output from the casout utility larger than 64K is now displayed correctly on the screen.

3192406 (1117734)
• Previously, console.000 was always overwritten when console.log max size was specified.

3192214 (1117565)
• In MQ series support, the MQCSP block which can be passed on an MQCONNX call and carries user

credentials, was not being converted. This resulted in MQ connection failures.

3191698 (1117032)
• When an alternate user ID is supplied on an MQ call, it is now authorized against the server's active

ESMs.

3183523 (1117005)
• Under certain circumstances, a batch job which used EZSOKET calls could abend for exceeding its job

card's TIME parameter before that period had expired.

3181745 (1116242)
• The association of a XA switch module with a batch unit of work now returns an error if the XAR cannot

be associated. This change might affect DSNRLI, DSNALI, and TSO in Batch(IKJEFTxx) processing.

3178489 (1118208)
• The fixed transaction property for a terminal resource was not being honored correctly.

3176086 (1115790)
• An intermittent issue with SSTM jobs not running after the region has started has been resolved.

3175925 (1115789)
• HSF records following a date rollover are no longer intermittently recorded as occurring on the previous

day.
• An issue which caused a memory corruption on shutdown when using JCL HSF has been resolved.
• Hexadecimal prefixes can now be defined in Scale-Out Repository (SOR) models. See "PAC and SOR

Environment Variables" in your product Help for more information. A new exit, TSTDSRUE, has been
provided to determine whether or not to direct a TS or TD access request to a SOR at queue access
time. Usage of this exit causes any SOR models that have been defined to be ignored. See
"Configuring TS and TD Queues for SOR Storage" in your product Help for more information.
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• The XML export of resource definitions now ignores any resources that are in groups that have names
starting with "DFH".

• Security Fix: A vulnerability within ESMAC which made the Web UI more susceptible to reverse
tabnabbing has been removed.

3216053 (1119150)
• If MFDS_DNS_RESOLVE=Y is set, the resolved hostname of the requested address for a listener is

used for the ESMAC URL from MFDS, even if the listener is specified with an IP address in the listener
definition.

3194907 (1117388)
• Some issues with sorting jobs on the spool page have been resolved.

3194166 (1117179)
• ITRs are now routed to the target SEP via castsc.

3193937 (1117152)
• An issue with Reply to console page in ESMAC has been fixed.

3192888 (1117078)

• The ESXDBOPC RM switch module has been updated to provide further clarification for optional open-
string customization.

3223990 (1119899)
• A new XA Switch build option - mssql17 - allows the use of the SQL Server ODBC 17.3 driver (and later

versions).

3220548 (1119748)
• APPLNAME is now set when DSNRLI SIGNON is called with an argument.

3219384 (1119464)
• After a SRRCMIT/SRRBACK call, the connection is now being set correctly.

3218880 (1119427)
• The ODBC XA switch now initializes and starts correctly when MFDBFH is enabled.

3218343 (1119410)
• There is no longer an issue with running an XA job after cancelling an XA job in ESMAC.

3218095 (1119496)
• New functionality now enables you to store all or part of an XA open string in a vault using the Micro

Focus Vault Facility.

3217806 (1119289)
• The ODBC switch now handles IMS BMP jobs correctly when the BATCHONLY=T option is specified.

3212998 (1119040)
• XAR now uses the long username for connections during user impersonation if the new open string

option LNAME=T is specified.

3203042 (1117973)
• The XA module for XDB now builds without any issues in the Enterprise Developer 5.0 products.

3199440 (1117649)
• XA switch modules now recognize IMS transactions correctly.

3198981 (1117710)
• The DB2 XA switch module now handles user impersonation and the packagepath option correctly.

3166472 (1118325)
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Enterprise Server Auditing

Back to the list

• Enterprise Server auditing no longer hangs if auditing is enabled for the External Security Facility but no
audit configuration file is present, and the Audit Manager is not running.

Enterprise Server Common Web Administration

Back to the list

• An issue with viewing regions in ESCWA using an MF Directory Server process secured with the Micro
Focus Internal Security has been resolved.

• The ESCWA user interface now performs validation in the same was as the Enterprise Server MFDS.

3194067 (1117163)
• It is now possible to add a color to a directory server's region through its General> Appearance drop-

down list. This enables you to change the color of the region in the tree, and the background color of the
region's pages. This setting overrides the directory server's colors, if they were already set.

3132670 (1111980)
• It is now possible to add a color to a directory server from the server's General > Appearance drop-

down setting. Use this setting to change the color of the directory server in the tree, in the background
color of the directory server pages and all of its region pages.

2869809 (1105847)
• The Monitor > Properties page now displays the list of Pending Requests under counts. This represents

any type of pending requests for the region.

Enterprise Server Security

Back to the list

• mfsecretsadmin no longer fails on HP-UX platforms.
• The mfsecretsadmin utility now supports specific secrets configuration files.
• Invalid keys in mfsecrets no longer result in a crash.
• mfsecretsadmin no longer incorrectly displays an error message when writing to a directory that does

not exist.
• The secrets.cfg file has been moved to the default vault location.

• Enterprise Server mainframe-style passtickets, used by the ELF and DCAS features, are now supported
when LDAP bind-mode verification is used.

3223436 (1119810)
• In Enterprise Server, the External Security Facility's OS ESM module now supports the Enterprise

Server Digital Certificate Authentication Service (DCAS).

3222786 (1119760)
• An Enterprise Server region running in a PAC and using MFDBFH for the region database with the

database "reslocking" feature supported, and with the External Security Feature enabled, would
periodically log messages similar to "ESFEV0331E Unable to unlock shared memory".

3218610 (1119357)
• An additional configuration option related to retrying on failure, retry bind, has been added to the

MLDAP ESM Module. See MLDAP ESM Module Custom Configuration Information topic in your product
Help for more information.

3215526 (1119267)
• The Enterprise Server External Security Facility's rule-substitution feature now supports the token $

{user_long}, which is replaced with the user's "long name".

3210400 (1118613)
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• In the Enterprise Server External Security Facility's administration, in rare circumstances, a one-byte
buffer overflow could occur when processing a list-user request, potentially resulting in heap corruption.

3209383 (1118627)
• In an Enterprise Server security configuration with two or more security managers using the MLDAP

ESM Module, all-groups mode enabled, and group federation enabled, certain ESF Update requests
including the "Update All" button in the Enterprise Server Administration web interface could result in
users losing group membership information. This has now been fixed.

3208297 (1118513)
• Enterprise Server's MLDAP ESM Module has a new option, "maximum qualifiers for initial check", which

enhances the existing "check TLQ first" option. See “MLDAP ESM Module Custom Configuration
Information” in your product Help for more information.

3201021 (1117790)
• The Enterprise Server MLDAP ESM Module's tracing of the effective rule and result for Auth/XAuth

requests now includes the resource class as well as name.

3200710 (1117799)
• In Enterprise Server security configurations using multiple Security Managers with the MLDAP ESM

Module, where all-groups mode is enabled and federation is disabled, user group membership is now
maintained correctly.

3194825 (1117275)
• The MLDAP ESM Module no longer generates "invalid search filter" errors when using OpenLDAP to

search for users with special characters in their LDAP Distinguished Names.

3194796 (1117268)
• Enterprise Server on Linux now includes a PAM ESM Module, which can authenticate users using the

Pluggable Authentication Modules mechanism included with the operating system.

3176983 (1115874)
• An issue with modifying Enterprise Server user groups with names beginning with the hash character

("#") has been corrected.
• An issue with some identifiers that contain the equals sign character ("=") when using LDAP-based

security in Enterprise Server has been resolved.
• es_default_ldap_openldap.ldf no longer deletes entries from the specified LDAP server. Instead, if you

are performing an upgrade you can use the new es_default_delete_ldap_openldap.ldf to delete these
old entries.

File Handling

Back to the list

• An OPEN OUTPUT operation on an ESDS file, with directive NOFCD3 set, now correctly returns a 00
status.

3224463 (1119982)
• A file status of 9/41 was sometimes incorrectly reported when a file was accessed by many users,

under intensive file I-O. This has now been fixed.

3214504 (1119352)
• Any 9/41 additional status errors will not be logged to XFHLOG if /dev/null or NUL is used.

3214504 (1119652)
• The File Handler running under Enterprise Server no longer returns a file status 500 when trying to

retrieve the next DD.

3211622 (1119086)
• Specifying OUTDD"SYSOUT 121 R" when MF_CBLQDA=ON is set could cause a file locked status for

SYSOUT to occur.
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3201420 (1117813)
• Fileshare no longer crashes when run in background mode and signal is processed.

• Rebuild now correctly reports the permitted number of duplicates for idxformat 12.

3201916 (1117985)

• Enterprise Server XA reconnections failed to register with MFDBFH following the loss of the original
connections - for example, through the use of the Db2 FORCE APPLICATIONS ALL.

3226856 (1120160)
• Error messages are now reported to the Enterprise Server console, and the region start-up fails, if an

attempt is made to warm start a region using a region database that had not previously been cold
started.

3226448 (1120167)
• A trace event is now output each time an I/O operation occurs that requires an XA connection and no

XA connection for the underlying datastore has been registered. This is designed to help with
diagnosing any file access problems.

3222022 (1119691)
• Specifying "localhost" as the hostname to recover when using "dbfhadmin -openfiles -recover -

host:localhost" or "dbfhadmin -casprocess -recover -host:localhost" failed to resolve to the current
machine name, resulting in the command failing.

3221354 (1119628)
• dbfhdeploy was not reporting the underlying ODBC error that resulted from a database connection

failure.

3221103 (1119661)
• If a single Db2 database hosted a datastore and a region with the same name, database operations

would fail for the region if the datastore had been accessed first (and vice versa) due to the same
database connection and schema being used for both the region and the datastore.

3219905 (1119487)
• The Micro Focus Database File Handler (MFDBFH) documentation now includes a reference topic

listing the database permissions required to create new databases, and to handle data files stored in a
database. Administrators can use this information when setting up roles within their database instances.

3217410 (1119273)
• DB2 support has been added to MFDBFH.

3203127 (1117981)
• dbfhdeploy can now be used to download files that are opened for read-only access by other processes.

Previously, you could only download only files that were not open by other processes.

3202402 (1117910)
• When using a Db2 MFDBFH datastore, an exception occurred when attempting to lock an already

locked record.
• dbfhadmin did not output an error message to indicate that the specified datastore URL (specified by

the -datastore: command-line option) did not have a corresponding configuration entry in the
MFDBFH.config file.

• When using PostgreSQL, when a KSDS file was deleted, the associated rewrite stored procedure was
not being removed.

• CAS processes using database resource locking no longer crash with a primary key constraint error
when attempting to create global locks.

• An RTS 114 error occurred when copying a database-hosted file to another database-hosted file if
either the source or destination file URLs specified a datastore for which there was not an MFDBFH
configuration file entry.

• "dbfhadmin -openfiles -recover" was incorrectly reporting that no files had been closed when the open
files were in the root folder.
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• Deleting a large number of files in a single operation sometimes failed due to the database's transaction
log becoming full when using a DB2 MFDBFH datastore.

• An error message RTS 114 could occur during CASCD termination when the ES_DB_SERVER
environment variable had been set, but no associated region database was configured.

• The "dbfhdeploy delete" command has been enhanced to allow the deletion of a folder (and all of its
sub-folders and files), and to allow the deletion of multiple files in a folder using a filename filter (such as
replacing characters in a file name using a wildcard, '*', and/or a question mark, '?').

• Reading a record from a transactional file hosted in a PostgreSQL would hang if that record had
previously been written within the same CICS transaction.

• The dbfhadmin command line utility now allows you to list/free region resources that are still locked after
a system failure. Use dbfhadmin -region -list|-recover

• Active TDQs hosted in MFDBFH datastores were not displayed by ESMAC if they had records locked by
a concurrently running transaction.

• CASSI processes would sometimes hang on termination, following a previous soft kill of a job, when
Db2 datastores were being used.

• A new command line utility - dbfhconfig - enables you to build and maintain a database configuration
file, meaning that you are no longer required to hand-craft the file. You can also use a secrets vault to
store sensitive logon credentials , instead of these being on view in a configuration file. Finally, a CTF
trace can be configured to trace ODBC and vault-related operations.

• This product now includes the dbfhconfig utility. It enables you to create and maintain an MFDBFH
configuration file eliminating the need to manually edit the XML file. Optionally, you can use dbfhconfig
to add any passwords and connection strings associated with DSN entries to the product's secrets
vault.

• Cancelling a job which was waiting for an ENQ did not always remove the ENQ request from the
(cross-)region database.

• MFDBFH no longer fails if the MFDBFH_SCRIPT_DIR and/or MFDBFH_CONFIG environment
variables specify a quoted path name.

• Unpredictable results could occur for applications with files open in two or more datastores due to a
clash of file handles.

• It is now possible to switch on/off I/O file optimization when deploying files via the dbfhdeploy command.
Also, file optimization is now available for ESDS, KSDS, and RRDS files hosted in a database, that are
opened for input - add optio="+oi" to mfdbfh.cfg to enable.

• MFDBFH now automatically reconnects the Db2 datastore and any (cross-)region database
connections when they are lost.

• Intermittent ODBC errors could occur during JES initialization after the termination of an initiator
process running a job in a previous session.

• dbfhdeploy incorrectly reported that a datastore did not exist for SQL Server operations when the
"master" database had not been configured. A similar issue occurred for PostgreSQL datastores when
the "postgres" database had not been configured.

Form Designer

Back to the list

• 64-bit versions of nmcnvrti.obj and nmcnvrto.obj have been added.

3207452 (1118373)

Header-to-Copy Utility

Back to the list

• h2cpy could produce an RTS 114 error if the number of DEFINES was greater than 167.

3220579 (1119558)
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IDE

Back to the list

Resolved issues with Eclipse:

• The incremental build processing for BMS was not correctly handling alternate output locations to the
main output folder. Incremental build worked if everything was going into the same output folder. This
has now been fixed.

3225243 (1120031)
• Images in the IDE are now correctly auto-scaled on high-resolution DPI.

3224931 (1119997)
• When using the Eclipse IDE to create data-driven unit tests that have a csv file with a header greater

than 511 bytes the test creation would fail. This has been fixed.

3223772 (1119829)
• An issue related to how copypaths for copybooks in linked folders are set up has been fixed.

3218555 (1119493)
• An issue related to how copybook paths are set up in the user environment settings has been resolved.

3217472 (1119287)
• COBOL programs located in linked folders were not finding the correct .mfdirset file when using a single

file compile. This has now been fixed.

3216339 (1119355)
• A problem preventing deserializing the runtime configuration xml has been fixed.

3214678 (1119016)
• Enterprise Developer and Visual COBOL can now parse XML generated by the Compiler when creating

a Web Service that contains the value “zero” when previously it could only process the numeric value.

3214559 (1118996)
• Web service mapping for both SOAP and REST web services is now mostly consistent between default

and manual mapping. The exception being types like zz9, which will remain "string" for SOAP web
services and "number" for REST web services. You can override this if required, using the field
properties to set correct field type.

3214314 (1119002)
• Resolving copybook paths resulted in the format program feature failing. This has been fixed.

3214035 (1118969)
• The mfdirset files for SQL programs are no longer generated upon project reload.

3212007 (1118810)
• You can now use the shortcut keys Ctrl+Shift+Z to compile single file JVM COBOL projects.

3211812 (1118772)
• Micro Focus recommends that you do not use a linked folder as an output folder, this can result in

unexpected project behavior. Such as, project files being deleted or overwritten.

3210830 (1119232)
• When creating a new Remote Java Application debug configuration, if you clicked on the Source tab

and then Add, a duplicate Remote File System Directory folder would be displayed. This has now been
fixed.

3210830 (1119234)
• When adding a project dependency (such as a copybook project) that resided in a folder not named the

same as the project, the assets were not found at compile time or when performing a background parse.
This has now been fixed.

3210496 (1119035)
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• The derived flag is now set correctly when the output folder is a sub-folder.

3208391 (1118448)
• The Compile file context menu option is now available for secondary source files.

3208344 (1118443)
• Debugging of JVM COBOL sources located using a path containing spaces no longer throws errors.

3208193 (1118531)
• Opening a copy file in the COBOL editor which contained multiple error markers might degrade

performance. This has now been fixed.

3207063 (1118471)
• Performing a Ctrl + mouse click on a variable during two-pane editing no longer causes Eclipse to throw

an exception.

3206046 (1118403)
• A Net Express project which contained Windows resource files were incorrectly converted to a COBOL

project. In addition, character corruption occurred in the converted build configurations. These have now
been fixed.

3205337 (1118167)
• .mfdirset files for COBOL programs in linked folders are now loaded from the correct .settings folder

under the project when using single file compile.

3204894 (1118133)
• The environment variable COBPATH was not being inherited from the correct locations. This has now

been fixed.

3204315 (1118116)
• A rare issues with some machines could occur where the machine could have difficulty interacting with

the code analysis services. This has been resolved by upgrading the internal Web service client
software.

3204257 (1118076)
• Null Pointer Exception is no longer received when Eclipse executes the "determine directives"

command.

3203931 (1118127)
• SourceConnect file filtering is now working correctly: case-insensitive filter strings can now be used, and

the "Show files only" option is respected.

3202067 (1117895)
• The COBOL editor could show incorrect error messages for linked resources with file-specific COBOL

settings. This was due to the file settings being ignored.

3197950 (640058)
• Editing in Block Selection mode with Smart Edit enabled now works correctly in the COBOL sequence

area.

3195496 (1117297)
• Debugging COBOL programs with Eclipse might be slow when large numbers of breakpoints are

specified.

3195046 (1117630)
• Incremental linking will no longer attempt to relink object files which have the same timestamp as the

resulting executable output. This prevents an issue where filesystems with less granular timestamps
could cause unnecessary relinking when the linking process had previously completed within a second.

3188828 (1116800)
• When a Build Environment script is specified in a project, any copybook paths specified on the project

Build Path are now included in COBCPY when building.
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3164533 (1117034)
• Server Explorer could not export to a location that contained spaces in the path. This has been fixed.

3164533 (1117924)
• Exporting a region for the second time to the same location now works correctly.

3164533 (1117925)
• When COBOL source files were included in sub-folders of the project, the analysis was failing because

the data was not being generated in the correct location. This has now been fixed.

3161441 (1114519)
• Additional directives from Project, Build Configuration, Folder, and File setting levels are now correctly

appended when performing a background parse.
• Duplicate lines are no longer added to the eclipse.ini file when a Patch Update is installed.

Resolved issues with Visual Studio:

• The build action is now set correctly for resource files in projects imported in Visual Studio using the Net
Express Import Wizard.

3224012 (1119877)
• The IntelliSense suggestions for completion of IF and EVALUATE statements now include alphanumeric

functions.

3220860 (1119561)
• When debugging a Mainframe Subsystem application, and the "Launch" option in the debug properties

of the project is set to "Any", you receive a warning message when debugging starts. If you do not want
to receive the message, you can disable it from the Visual Studio options - click Tools > Options >
Debugging > Micro Focus COBOL, and check "Do not prompt when using the 'Any' launch option".

3220636 (1119730)
• A new Visual Studio debug configuration option, "Do not stop on program entry", is now available. With

this enabled, the debugger only stops at breakpoints and not on transactions.

3216870 (1119253)
• If a build of a PL/I application failed with an error, subsequent builds could be skipped.

3214047 (1118952)
• The "Application Configuration File" item template for native projects now has a .mfgcf extension

instead of .config. There is no change in the functionality of that file.

3211374 (1118723)
• The Show Catalog and Show Spool context-menu commands in Server Explorer now display the

requested information without requiring a login.

3211044 (1118709)
• The debug tooltips now show the correct value for table items that are qualified.

3210340 (1118624)
• When starting the Data File Tools utility from Visual Studio, it is started with the environment variables

set on the current project.

3208983 (1118682)
• Cleaning a project now deletes all the project's output files.

3208289 (1118702)
• The values of COBOL data items can now be displayed in the Immediate and Command windows when

debugging native code.

3208044 (1118424)
• Automatic insertion of COBOL scope delimiters such as END-IF is now supported for all COBOL

dialects that allow the relevant language syntax.
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3207789 (1118388)
• .INT and .GNT files are now compiled in the intermediate output directory and copied to the project's

output directory.

3203363 (1118678), 3203345 (1118079)
• The output files for a source file removed from the project are deleted when the project is built.

3203284 (1117998)
• The output files for a source file which is removed from a project will be deleted during the next build of

the project.

3203283 (1117997)
• The .IDY files for the Micro Focus INT/GNT project type are now generated in the same directory as the

generated .INT and .GNT files.

3203070 (1117984)
• Compiling an Assembler program or a COBOL source file in a INT/GNT project now correctly copies the

Compiler output to the output directory.

3202111 (1117881)
• There is no longer an issue with installing Visual COBOL or Enterprise Developer to a machine that has

the Microsoft Build Tools product installed.

3198943 (1117841)
• There are new editor formatting options in Visual Studio that enable child data items to be aligned

relative to their parent data items.

3198752 (1117634)
• When displaying the Enterprise Server Administration page, the spool or the catalog in the browser

inside Visual Studio, a secure URI is now used if the enterprise server instance is secured.

3198521 (1117609)
• When the debugger fails to attach to an Enterprise Server, if any error information is available it will be

displayed in the Enterprise Server output window in Visual Studio.

3197752 (1117608)
• COBOL types and members will now be updated for source files that contain parse errors.

3193694 (1117160)
• The 'Full Path' property is now displayed in the Properties window when a copybook is selected in

Solution Explorer.
• When debugging native COBOL code, stepping over a STOP RUN or a GOBACK statement and

immediately stepping back into the debugger no longer causes an 'Unable to step. Catastrophic failure'
message to be displayed.

• When viewing the contents with replaced values of a copybook referenced in a COPY...REPLACING
statement, a Program Symbols (.IDY) alert bar is no longer shown.

• If both the condition text and hit count are changed for a conditional watchpoint, the watchpoint is now
correctly updated.

• The COBOL Visualizer now displays a word wrap option when you select the text tab.
• The COBOL Visualizer no longer truncates the display of data items containing null bytes when

debugging .NET COBOL code.
• Previously, the context menu in Server Explorer was slow to display when selecting a server

immediately after starting Visual Studio, or when a large number of servers were defined.
• Adding a resources file (*.resx) to a .NET Core COBOL project no longer results in build errors.
• The Settings File editor now correctly opens settings files in .NET Core COBOL projects.
• The SQL Property page for .NET Core projects has been removed because .NET Core projects cannot

include SQL database access.
• You can now navigate to the source code of a program shown in the Program Flow and Data Flow views

when the COBOL editor option 'Enable Expanded Copybook View' is set to false.

Resolved Issues | 45



• It is now possible to navigate to the source code of a program shown in the Program Flow and Data
Flow views when the COBOL editor option 'Enable Expanded Copybook View' is set to false.

• COBOL projects could not be built when using Visual Studio 2019 16.3.
• There is no longer an issue with creating new SQL CLR projects in Visual Studio 2019.
• IntelliSense could stop working when copybooks referenced in the editor using COPY... REPLACE

statements were expanded.
• New copybooks created using the "Extract to Copybook" command will not be added to the project in

Solution Explorer. They are now referenced in the project with the Copybook Paths property in the
Properties window.

Interface Mapping Toolkit

Back to the list

• A problem that caused an erroneous JSON response to be generated when an empty array was
present has been fixed.

3217017 (1119563)
• You could receive an intermittent failure if you code has interfaces that contain multiple parameters that

each map to linkage items containing COBOL tables defined with the OCCURS DEPENDING ON
clause. This could occur due to referencing of freed memory.

3179075 (1116037)

• XML parsing has been enhanced to correct an error that occurred when generating a SOAP Web
service that uses the word "zero" to represent the numeric value '0'.

3209106 (1118548)
• Remote external paths (specifically, things included on $COBCPY) are now correctly calculated when

generating a web service or Java interface from a remote project.

• Enterprise Server now supports JSBIND files greater than 1MB in size.

3208935 (1118688)
• When using Web Services, a COBOL service with a parameter containing nested OCCURS

DEPENDING ON tables no longer crashes if one of the nested tables is of a primitive data type.

3204381 (1118234)

• When sending a request to a CICS Web Service, data for all "FILLER" group items within the same
COBOL group are now correctly returned.

3221568 (1119656)
• A problem that caused a CASPI1009E error-OUTPUT_OVERFLOW to occur when a SOAP message

was sent for channel-based SOAP services having string data greater than 64K has been corrected.

3209490 (1118583)
• You no longer receive a message "Directive -C invalid or not allowed here" when running ls2ws under

UNIX or Linux.

3209071 (1118509)

Licensing

Back to the list

• Windows Server 2016 machines might need to be restarted regularly because of a large number of
open handles on the mfcesd (Micro Focus Compliance Enforcement daemon) process. The open
handles are now freed correctly and will no longer accumulate.

3213000 (1118881)
• The product Help now includes instructions for how to manually enable an Automatic Restart of the

SafeNet License Daemons on Linux using SystemD.
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3210607 (1118628)
• During installation, the directory structure of /var/microfocuslicensing will now have the correct and

secure permissions set.

3179691 (1116046)
• An application being deployed using the CESDYNAMIC option of a Runtime Launch Configuration file

now succeeds in getting a licence when executed for a second time.

3160922 (1114454)

Micro Focus Common Client

Back to the list

• Memory-access errors no longer occur in MFCC (mclient.dll/ cobmclient.so/libmclient.so) when certain
malformed messages are received from the server. MFCC now detects these conditions and logs an
error message.

3213653 (1119419)
• cassub and other Enterprise Server utilities now support host names of up to 255 characters long.

3196153 (1119249)
• The IMTK service-deployment function can now read credentials for secured deployment services from

the MFCC configuration file mf-client.dat.

Micro Focus Directory Server

Back to the list

• MFDS CA server root certificate and TLS client options are now available via the ESCWA UI.

3218442 (1119593)
• The Shared Memory Cushion entry field in the Enterprise Server Administration UI now accepts five

digits.

3210200 (1118594)
• If external security is configured for the Micro Focus Directory Server (MFDS), then a user attempting to

import region configuration using the "mfds -g" command now requires "Add" and "Delete" permissions
for the "Repository Access" resource under the "Enterprise Server Administration" resource class.

3209555 (1118581)
• The mfds -g command line waits to time out rather than receiving an immediate fail as a result of an

import error.

3209555 (1118572)
• In some circumstances, the Micro Focus Directory security settings were not being saved. This has

been fixed.

3209389 (1118705)
• If the MFDS process is not TLS-enabled, setting the MF_ROOT_CERT environment variable could

cause region startup to fail. This has now been fixed.

3205462 (1118274)
• The Micro Focus Directory Server KEEPALIVE and some other connections to a TLS-enabled

Communications Process Control Channel listener were failing to connect. This was because they were
using the IP address rather than the hostname which the certificate requires.

3204824 (1118193)
• If the MFDS -o option is used to override the options file location, option changes were not successfully

saved. Use the same location when saving option changes, and this problem does not occur.

3171825 (1115391)
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• ESDEMO64 is now in the standard MF Directory Server startup repository together with ESDEMO. If
the MSSIVP repository is imported it contains MSSDEM64 together with MSSDEMO.

3168860 (1115116)
• On UNIX, if the MFDS "Default process user ID" value is set, from either the GUI or with the "mfds -f"

command line option, before the MFDS process starts, it will change its effective uid to the specified
value after it has started listening on its configured endpoint. This enables the MFDS process to run
using a non-root uid while still using the default privileged port 86. If the uid specified is invalid, the
MFDS process terminates.

3122797 (1119862)
• If the environment variable MFDS_DNS_RESOLVE=Y is set, then the Enterprise Server Administration

web interface's HTTP response headers will not return the MF Directory Server IP address in HTTP
cookie values.

2863212 (1104835)
• Previously, changes made to the listener configuration in the Enterprise Server Administration Web UI

were not becoming active for a started region.
• The MF Directory Server process could abnormally terminate if the listener description text input via the

Enterprise Server Administration Web GUI was greater than 64 characters in length.
• A number of XSS vulnerabilities in the Enterprise Server Administration have been resolved.
• Under some circumstances, it was possible to set MFDS restricted access with improper credentials

checks.
• Any region auto-start credentials and XRM open string values are now stored in the MF secrets vault

facility if the Micro Focus Directory Server is configured to use it.
• When the Micro Focus Directory Server is running in a container, the region status is set to started only

when all expected listeners are started.
• The mfds -l schema export command-line option now supports the OpenLDAP OLC (on-line

processing) LDIF file format (use option 4).
• When adding a listener using the Enterprise Server Administration Web UI, the initial listener state was

incorrectly set to "Invalid".
• In the Enterprise Server Administration Web UI, the service namespace values of the deployed REST

services were incorrectly displayed.
• MFDAS XML import can now import more than one comms process.
• The ESCWA API would reject adding a listener to a region if there was already a listener with the same

requested fixed port value defined in the target MFDS.

MF Server Administrator (GUI)

Back to the list

• There is no longer an issue with using the mfds -g option to import an XML region definition with
services that reference listeners.

3219549 (1119459)

Micro Focus Unit Testing Framework

Back to the list

• We recommend that you rebuild your unit test shared objects, or dynamic link libraries, or any file that
includes mfunit.cpy, as a change in the contents of this copybook might result in a run-time error.

3222692 (1119866)
• Micro Focus Unit tests with data driven tests that use CSV have had some size limit increases.

3214717 (1119038)
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Run-Time System

Back to the list

• The NUMVAL intrinsic function no longer produces an error at run time when used with national data in
a program compiled with a mainframe COBOL dialect.

3191506 (1117099)
• The CBL_GET_EXIT_INFO library routine has been further enhanced to detect the circumstances in

which an exit procedure has been invoked. It can now better distinguish between normal and abnormal
terminations.

• In .NET and JVM COBOL code, under numproc(acos), some instances of illegal data in a USAGE
DISPLAY field did not produce an RT163 error when should have.

3215249 (1119051)
• .NET and JVM COBOL only. An issue has been resolved in arithmetic statements where the target item

is a binary item 9 bytes or larger (19 decimal digits or larger) and the result has magnitude which is
greater than or equal to 2**64.

• In .NET COBOL, the default printer routine now successfully searches for and selects a default printer
without causing a system exception "Argument out of range".

3224679 (1119932)

• A statement of the form "compute item rounded = expression" where expression includes at least 1
comp-1 or comp-2 item sometimes gave the wrong result because it did not perform the rounding. This
has been fixed.

3224247 (1119910)

Setup

Back to the list

• When installing on UNIX, the MFDS and SSL configuration files are stored under /opt/microfocus/config
and symbolically linked back to the installation location. When Patch Updates are installed to the same
location, the configuration is now preserved.

3212913 (1118927)

SQL: COBSQL

Back to the list

• COBSQL now supports EBCDIC conversion for FETCH statements with more than ten host variables.

3225338 (1120132)
• Informix now handles cases in which comments were included inside EXEC SQL statements or variable

declarations were broken into two lines inside EXEC SQL statements.

3220792 (1119585)
• OpenESQL now correctly handles calling Stored Procedures with output host variables which use the

dynamic SQL method.

3212664 (1118834)
• A problem that prevented COBSQL from reporting errors to the checker when the precompiler file was

missing has been fixed.

2867407 (1105864)

SQL: DB2

Back to the list
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• An issue with ODBC and DB2 ECM generated code not having uniquely named sections has been
resolved.

3224210 (1119896)
• XML data is now correctly sent to the DB2 server.

3220909 (1119685)
• DB2 ECM now handles the CLOB value in EBCDIC correctly when DIALECT(ENTCOBOL) is specified.

3217813 (1119335)
• There is no longer a problem compiling programs with host variable arrays if they are used with the

SELECT INTO statement. A problem with the output host variable array processing where array HVs or
a mix of array and individual HVs were being processed incorrectly has been fixed.

3216314 (1119188)
• The MFHCO tool now takes login credentials from the command line for remote database access

without asking for user inputs through a pop-up window.

3212431 (1118968)
• A ddl command which contains a number of characters greater than 32K could cause a hang condition

in the HCO for DB2 LUW ddl generation tooling.

3205207 (1118168)
• The DB2 ECM was incorrectly handling floating point conversion when runtime option

MAINFRAME_FLOATING_POINT was enabled. This has been fixed.

3198121 (1117644)
• DB2 ECM now supports multi-row FETCH/INSERT/UPDATE, which includes but is not limited to the

usage of the FOR nn ROWS clause.

3155753 (1114251)

SQL: OpenESQL

Back to the list

• An issue with Visual Studio 2019 caused Micro Focus SQL Tools windows to appear blank. This only
occurred in Visual Studio 2019 version 16.1 or later, with .NET Framework 4.8 installed, and with the
"Optimize rendering for screens with different pixel densities (requires restart)" option enabled.

3211113 (1118674)

• The OpenESQL run-time system now handles WITH-HOLD cursor correctly when using FETCH FIRST
orientation.

3225154 (1120007)
• You no longer receive an error in the OpenESQL Assistant when trying to run a query that used the

same column referenced by an alias in two or more tables.

3223933 (1119902)
• The SQL Server datetime values are no longer returned with trailing zeros to a host variable of PIC

X(26). An issue with the OpenESQL processing of datetime of SQL Server where padding characters
were being processed incorrectly has been resolved.

3220692 (1119579)
• When calling stored procedures with null indicator host variables, the OpenESQL Run-Time System

now executes correctly without returning an SQLCODE -10000 error.

3219732 (1119869)
• When multiple dynamic XA switches that use OpenESQL technology (such as MSSQL, PostgreSQL,

and ODBC switches) are specified in an Enterprise Sever instance, they are now started without an
error in xa-prepare.

3218857 (1119445)
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• The sqlerrd(3) in SQLCA now returns the correct number of rows affected by command INSERT and
DELETE.

3217469 (1119456)
• OpenESQL runtime now handles the @@NESTLEVEL function correctly.

3211849 (1118757)
• An issue with how the SQL managed runtime handles char, varchar, nchar, and nvarchar types in SQL

Server CLR stored procedures where a host variable size is greater than 8,000 has been resolved.

3211090 (1118718)
• The OpenESQL parser now handles SQL statements inside parenthesis correctly.

3210644 (1118643)
• The OpenESQL run-time now handles Informix ODBC errors correctly.

3208869 (1118722)
• The OESQL managed runtime now handles FINAL TABLE statements correctly.

3208718 (1118469)
• An issue with having to perform an ALLOCATE after every OPEN CURSOR to avoid an error has been

resolved.

3206739 (1118395)
• Nested programs with the same PROGRAM-ID now insert records correctly.

3204730 (1118134)
• Native COBOL programs with multiple program id sections no longer failed to compile in 32-bit

compilation. Previously, this failed with redefine symbol error messages.

3204730 (1118842)
• Closing a Windows Forms application compiled with DBMAN=ADO no longer fails with a

NullReferenceException.

3202426 (1117914)
• An issue during COBOL compilation where incorrect error messages (such as "Access plan load error"

or "DBRM not found in plan") could appear no longer occurs. This could happen in release 4.0 or later.

3202086 (1118511)
• OpenESQL now handles long column names without causing a truncated data warning.

3200934 (1117832)
• There is no longer an issue with expanding host variable groups regardless if whether the GEN-HV-

FROM-GROUP directive is applied. An issue problem with the host variable group processing where
non-sibling host variables were being processed incorrectly has been resolved.

3200753 (1117808)
• OpenESQL now handles and recognizes SQL Server's square brackets correctly.

3199039 (1117614)
• The OESQL JDBC run time now retrieves data correctly via the READ ONLY cursor.

3193117 (1117107)
• The DB2 SQL scripts for the following samples now include database creation - "OO WPF Book", "OO

WPF Book EXEC ADO", and "WPF Book". Check the samples' readmes for instructions.

SQL Option for DB2

Back to the list

• When the XDB directive option IGNORE-NESTED is used without a parameter, XDB ECM now
generates code in the outermost program only.

3218881 (1119399)
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• XDB ECM now handles multi-level group host variables correctly.

3215815 (1119114)
• XDB ECM now handles user-defined SQLCODE data items correctly.

3215357 (1119066)
• XDB ECM now handles group host variables in the IN predicate correctly.

3213813 (1118991)
• A new property has been added to the XDB JDBC driver that enables byte array data to be treated as if

it were encoded in the EBCDIC code page of the connection.

3203249 (1119097)

• XDB XA Switch logic now supports z/OS DB2 thread timeouts at XA_START time and reconnects stale
connections but only at XA_START.

3221852 (1119701)
• A problem with XDB XA that caused a z/OS DB2 SAVEPOINT error when a program rolled back to the

SAVEPOINT has been fixed.

3216066 (1119149)
• A thread abend in the XDB Link on Diagnostic Information DRDA flow has been resolved.

3199003 (1117688)
• A problem retrieving the value of the CURRENT PACKAGESET special register from the XDB Link

DRDA/AR client to z/OS DB2 has been resolved.

3186735 (1116600)
• A problem that caused z/OS DB2 to return an error when using packages bound with

DYNAMICRULES=BIND in addition to specifying COMMA as the Decimal Delimiter in the Options
dialog has been fixed.

3204116 (1118276)
• The warning pop-up dialog box for an invalid connection no longer appears when connecting with the

XDB ODBC Driver.

3208889 (1118496)

• A problem when using the XDB V11 emulation engine that caused the SQLWizard to improperly build
UPDATE statements that update result sets has been fixed.

3209886 (1118568)
• A problem with the XDB CREATE USER SQL statement's SECONDARY ID clause has been resolved.

3206448 (1118263)
• Previously, the V11 radio button was not visible in the About tab of the XDB Server Configuration Utility

even when the V11 engine DLL was available.

3198729 (1117593)
• A problem with recalculating field values during the projection of the result for SUBSTR/SUBSTRING

scalars with parameters 2 and/or 3 that contained field values has been resolved.

3196219 (1117383)
• A problem caused by a case expression built in reverse order has been resolved.

3195822 (1117449)
• The XDB Link DRDA/AR has been enhanced to process z/OS DB2 diagnostic information in all modes.

3187411 (1116687)
• When a location was successfully closed, a problem that prevented it from being marked as closed

caused an error to be generated when subsequently setting a location off-line. This has been fixed.

3184848 (1116525)
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• An issue with labeled duration arithmetic or row change timestamps using timestamps with precision
greater than six has been resolved.

3181837 (1116189)
• An issue causing an empty result set where index queues used to optimize correlated subqueries were

reset when the correlated subquery contained an IN predicate with a list of values has been resolved.

3199958 (1117713)
• The XUTLB grammar that processes LOAD statements now supports a NUMRECS clause between the

INTO TABLE clause and the column definition list.

XML Support

Back to the list

• XML PARSE now handles ISO-8859-15 encoded strings correctly in 64-bit mode.

3220045 (1119568)
• The XML run time now handles namespace prefixes correctly in the output XML document.

3219503 (1119447)
• XML PARSE now returns XML EVENT correctly without repeating the same event.

3219154 (1119556)
• The XML run-time system now detects and outputs the special xsi namespace correctly.

3201811 (1117879)
• The PREXML preprocessor now handles the COBOL source correctly, and prevents an unhandled

exception appearing in the IDE.

3200436 (1117735)

• If an environment variable is used in the ASSIGN TO clause, the XML runtime now returns the end-of-
file status correctly.

3220566 (1119552)
• The managed XML syntax support runtime now cleans up all the unwanted empty XML tags.

3209096 (1118515)
• XML PARSE now parses the subsequent parts of an XML document correctly.

3201432 (1117819)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 3220454 (1119529)
• 3205144 (1118152)
• 3216998 (1119233)
• 3168018 (1115086)
• 2868839 (1105831)
• 3222038 (1119767)
• 3184732 (1116467)
• 3224515 (1119919)
• 3136118 (1112519)
• 2885283 (1108043)
• 3211043 (1118683)

• 3119471 (1110898)
• 3201628 (1117842)
• 2820860 (1099521)
• 3222960 (1119817)
• 3220991 (1119565)
• 3208034 (1118409)
• 3221354 (1119662)
• 3208854 (1118475)
• 3224700 (1119954)
• 3214528 (1119048)
• 3165853 (1114869)

• 3208489 (1118495)
• 3196128 (1117344)
• 3133097 (1112263)
• 3167774 (1115016)
• 3222951 (1119971)
• 3221465 (1119695)
• 3208613 (1118449)
• 3208093 (1118467)
• 3207104 (1118323)
• 3204665 (1118597)
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release after release 9.0. The SafeNet Sentinel licenses will not be
supported after release 9.0 and you need to use AutoPass licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus SupportLine for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

2. Alternatively, you can download the product from the Product Updates section of the Micro Focus
SupportLine Web site.

System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The maximum disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

1.2Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit and 64-bit applications with Visual COBOL installed on a 64-bit
operating system.

• Support for development and deployment on Windows 7 has been discontinued.
• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These

platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.

• Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.
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Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Note:

• Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK's OpenJDK
8 (u202) with Hotspot.

• This product includes OpenSSL version 1.1.1c.

Visual Studio IDE

You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.4 or a
newer one installed in advance.

Note: An issue with Microsoft's Visual Studio 2019 version 16.8 or later affects .NET Core COBOL
projects created with version of Visual COBOL earlier than 6.0 PU4. To avoid the issue, install Visual
COBOL 6.0 Patch Update 4 or later with Visual Studio 2019 version 16.8 or later.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Visual COBOL setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF or SQL CLR application development.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.
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Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

Other Requirements

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine.

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following packages: the Windows SDK package and the Microsoft Build Tools
package. See Microsoft Package Dependencies for a full list of actions and operations that require one or
both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.

System Requirements for Visual COBOL for Eclipse (Windows)
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Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Also note the following:

• Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.

• You to produce both 64-bit and 32-bit applications with Visual COBOL on 64-bit operating systems.

• Support for development and deployment on Windows 7 has been discontinued.
• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These

platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.
• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 1.1.1c.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Eclipse requirements

• The setup file installs Visual COBOL and the 64-bit Eclipse 4.8.

Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.

• Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.

• Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

Software requirements

• Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

Note: Eclipse does not run using Java 11.
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• Visual COBOL requires:

• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.

• The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine.

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

x86-64
running Red
Hat Linux

Micro Focus 1.11 GB 4.42 GB 2.21 GB 50 MB

x64 running
SUSE SLES

Micro Focus 924 MB 3.70 GB 1.85 GB 50 MB

Operating Systems Supported

Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.
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For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Eclipse requirements

• Visual COBOL installs the 64-bit Eclipse IDE by default and requires a 64-bit Java installation.
• On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.
• On other platforms, Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-

bit Eclipse to create both 32-bit and 64-bit applications.
• The setup file installs Visual COBOL and the 64-bit Eclipse 4.8. After the installation, you can install

Visual COBOL as a plug-in into other Eclipse installations available on the same machine. The
supported versions are 4.7, and 4.8 for both the 32-bit and the 64-bit Eclipse. See Installing Visual
COBOL into other instances of Eclipse.

Note: On Red Hat platforms, you need Red Hat 7 or later, if you want to install Visual COBOL into
Eclipse 4.8.

Other software requirements

Before installing this product, you must have the following software installed on your computer:

• The unzip utility is required by the setup file.

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

On Red Hat 8.1, pax is no longer installed by default. You must install the spax version found in the OS
ISO. Use the yum install spax command.

• On Red Hat, if SELinux is installed, the "SELINUX" configuration must be disabled. To do this, set
SELINUX=disabled in /etc/selinux/config.

This enables the Micro Focus License daemons to start when the machine is booted and the Micro
Focus tools and programs to run correctly.

• Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library 32-bit Library
Name

64-bit Library
Name SUSE 12¹ SUSE 151 Red Hat 7

glibc2 glibc-*.i686 glibc-*.x86_64 X

libgcc libgcc-*.i686 libgcc-
*.x86_64

X

libstdc++ libstdc++-
*.i686

libstdc++-
*.x86_64

X

glibc-locale glibc-
locale-32bit

glibc-locale-2 X X

gtk2 N/A libgtk-2_0-0-2 X X

gtk2 N/A gtk2-tools-2 X X

Installation | 61

http://supportline.microfocus.com/prodavail.aspx


Library 32-bit Library
Name

64-bit Library
Name SUSE 12¹ SUSE 151 Red Hat 7

gtk2 N/A libXcomposite1
-0

X X

gtk2 N/A libgdk_pixbuf-2
_0-0-2

X X

gtk2 N/A gdk-pixbuf-
query-
loaders-2

X X

gtk2 N/A libjasper1-1 X X

gtk2 N/A gtk2-*.x86_64 X

gtk2-x11 N/A libgthread-2_0-
0-2

X X

libXtst N/A libXtst6-1 X X

libXtst N/A libXtst-
*.x86_64

X

glibc-devel glibc-devel-
*.i686

glibc-devel-
*.x86_64

X

PackageKit-gtk N/A PackageKit-
gtk-module-
*.x86_64

PackageKit-
gtk3

N/A PackageKit-
gtk3-module-
*.x86_64

X

gtk2-engines N/A gtk2-
engines.*.x86_
64

libcanberra-
gtk2

N/A libcanberra-
gtk2-*.x86_64

X

libcanberra-
gtk3

N/A libcanberra-
gtk3-*.x86_64

webkitgtk N/A webkitgtk.x86_
64

webkitgtk3 N/A webkitgtk3.x86
_64

X

webkit2gtk3 N/A webkit2gtk3.x8
6_64

xterm Any version Any version X X X

unzip Any version Any version X X X

libgnome N/A libgnome.x86_
64

X

gcc3, 4 gcc*.i686 gcc*x86_64 X X X

cpp3 cpp*x86_64 X
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Library 32-bit Library
Name

64-bit Library
Name SUSE 12¹ SUSE 151 Red Hat 7

libnotify-tools5 libnotify-
tools*x86_64

X X

Note:

• 1 On SUSE 12 or 15, you can only install the 64-bit version of Visual COBOL. The glibc-
locale-32bit library is still required by the SafeNet Sentinel licensed components.

• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for
the GNU Project Debugger) can be installed from the install media for your OS.

• 2On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 3 On Red Hat, these libraries are required to enable COBOL to compile.
• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 4 On Red Hat, only the 64-bit gcc libraries are required.
• 5 For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Visual
COBOL for Eclipse from a desktop icon. Execute the following command to install the libnotify-
tools library:

zypper install libnotify-tools

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

Note: Eclipse does not run using Java 11.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
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microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine.

System Requirements for Visual COBOL Development Hub

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

POWER
running AIX

Micro Focus 530 MB 2.12 GB 1.06 GB 41 MB

HP IA Micro Focus 911 MB 3.65 GB 1.83 GB 79 MB

System Z
running Red
Hat Linux

Micro Focus 437 MB 1.75 GB 875 MB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 615 MB 2.47 GB 1.23 GB 50 MB

SPARC
running
Solaris

Micro Focus 498 MB 2.00 GB 996 MB 42 MB

x86-64
running
Solaris

Micro Focus 469 MB 1.88 GB 938 MB 33 MB

System Z
running SUSE
SLES

Micro Focus 319 MB 1.28 GB 638 MB 39 MB

x64 running
SUSE SLES

Micro Focus 435 MB 1.75 GB 870 MB 50 MB

x64 running
Ubuntu

Micro Focus 440 MB 1.77 GB 880 MB 50 MB

x86-64
running
CentOS

Micro Focus 615 MB 2.46 GB 1.23 GB 50 MB

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.1.1c.

• On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.
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Before installing this product, you must have the following software installed on your computer:

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• pax - the pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux
systems but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or
pax --version at the command line.

On Red Hat 8.1, pax is no longer installed by default. You must install the spax version found in the OS
ISO. Use the yum install spax command.

• On Red Hat, if SELinux is installed, the "SELINUX" configuration must be disabled. To do this, set
SELINUX=disabled in /etc/selinux/config.

This enables the Micro Focus License daemons to start when the machine is booted and the Micro
Focus tools and programs to run correctly.

• Required libraries for Red Hat and SUSE Linux platforms - the installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Table 1: Default Libraries

The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.

Library 32-bit
Library
Name

64-bit
Library
Name

s390

Library Name

Platform

SUSE
12¹

SUSE 15 Red Hat 7 Red Hat 8

glibc2 glibc-
*.i686

glibc-
*.x86_64

glibc-*.s390 X X

libgcc libgcc-
*.i686

libgcc-
*.x86_64

libgcc-*.s390 X X

libstdc+
+

libstdc+
+-*.i686

libstdc+
+-
*.x86_64

libstdc++-*.s390 X X

glibc-
devel

glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-devel-*.s390 X X

glibc-
locale

glibc-
locale-3
2bit

glibc-
locale-2

N/A X X

gtk2 N/A libgtk-2_
0-0-2

N/A X X

gtk2 N/A gtk2-
tools-2

N/A X X

gtk2 N/A libXcom
posite1-
0

N/A X X
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Library 32-bit
Library
Name

64-bit
Library
Name

s390

Library Name

Platform

SUSE
12¹

SUSE 15 Red Hat 7 Red Hat 8

gtk2 N/A libgdk_pi
xbuf-2_0
-0-2

N/A X X

gtk2 N/A gdk-
pixbuf-
query-
loaders-
2

N/A X X

gtk2 N/A libjasper
1-1

N/A X X

gtk2 N/A gtk2-
*.x86_64

N/A X X

gtk2-x11 N/A libgthrea
d-2_0-0-
2

N/A X X

libXtst N/A libXtst6-
1

N/A X X

libXtst N/A libXtst-
*.x86_64

N/A X X

glibc-
devel

glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

N/A X X

Package
Kit-gtk

N/A Package
Kit-gtk-
module-
*.x86_64

N/A

Package
Kit-gtk3

N/A Package
Kit-gtk3-
module-
*.x86_64

N/A X X

gtk2-
engines

N/A gtk2-
engines.
*.x86_64

N/A

libcanbe
rra-gtk2

N/A libcanbe
rra-gtk2-
*.x86_64

N/A X X

webkitgt
k

N/A webkitgt
k.x86_6
4

N/A

webkitgt
k3

N/A webkitgt
k3.x86_
64

N/A X X

xterm Any
version

Any
version

Any version X X X X
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Library 32-bit
Library
Name

64-bit
Library
Name

s390

Library Name

Platform

SUSE
12¹

SUSE 15 Red Hat 7 Red Hat 8

unzip Any
version

Any
version

Any version X X X X

libgnom
e

N/A libgnom
e.x86_6
4

N/A X X

gcc3, 4 gcc*.i68
6

gcc*x86
_64

X X X X X

cpp3 cpp*x86
_64

X X

Visit the Red Hat Web site for more information.

• ¹ On SuSe 12 or 15, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit
library is still required by the SafeNet Sentinel licensed components.

• 2On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 3 On Red Hat, these libraries are required to enable COBOL to compile.
• 4 On Red Hat, only the 64-bit gcc libraries are required.

• Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

Note: Eclipse does not run using Java 11.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

• On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

To execute JVM COBOL code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
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Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine.

UNIX and Linux Installer Issues
• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without

loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.
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Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL for Visual Studio
To install this product:

1. Run the vcvsnnnn_30.exe file (where nnnn is the version of Visual Studio you're installing for) and
follow the wizard instructions to install the prerequisite software and the product.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Depending on how you plan to use the product, there could be dependencies on the Microsoft
Windows SDK and Microsoft Build Tools packages. The installer will install the latest versions of
the Microsoft Windows 10 SDK, and the Microsoft Build Tools for Visual Studio 2017, to their
default locations. Refer to Microsoft Package Dependencies to see if you will require these
packages, and if not, you can configure the installer to skip download and installation (see
Advanced Installation Tasks for more information).

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Visual COBOL for Eclipse (Windows)
Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.
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These are the steps to install Visual COBOL:

1. Run the vce_60.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.8 64-bit, with the Micro Focus plugins already
installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Visual COBOL for Eclipse (UNIX)
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_6.0_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_6.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_6.0_platform -installlocation="full path of 
new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

. /setup_visualcobol_deveclipse_6.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
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While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Installing Visual COBOL Development Hub
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_6.0_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_6.0_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_visualcobol_devhub_6.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
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• Check the Product Documentation section of the Micro Focus SupportLine Documentation Web site for
any updates to the documentation which might have been uploaded.

72 | Installation

https://www.microfocus.com/en-us/support/documentation/


Licensing Information
Note:

• Personal Edition licensing is only available with Visual COBOL for Visual Studio 2019 and Visual
COBOL for Eclipse

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• This package provides a license per supported Micro Focus Development Hub platform.
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• The latest version of the SafeNet licensing software is required. See the Software Requirements

section in this document for more details.
• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,

contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

Windows 8.1 From the Windows Start screen, click the License Administration tile.

Windows 10 and Later From your Windows desktop, click Start > Micro Focus License Manager >
License Administration.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

Windows

1. Start Micro Focus License Administration.
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2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product

Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click AuthorizeFinish to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.
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Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to Micro Focus Product Updates

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number . To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
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violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
© Copyright 2020 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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